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1.  

 

 

 

 

 

 

Chapter 1: Introduction 
 

CLINCK is a Cyber Café Security Management and Accounting application of Ideacts. Cyber Café owners get this free 

of cost. CLINCK consists of CLINCK Cyber Café Manager on the server side and CLINCK Desktop on the client side.  

 

CLINCK Cyber Café Manager helps the Café owner, in managing the Café efficiently. While, CLINCK Desktop is a 

navigational tool which provides the Café customers with an interactive desktop, to Search and access contents. 

 

CLINCK is operational in more than 250 cities. It follows the Security rules of the Law Enforcement Agencies with 

the motive to provide national security.  

 

1.1 About the Manual 
 

This manual provides detailed instructions on how to use CLINCK to secure the Café. The manual explains further in 

detail the installation steps to install both CLINCK Desktop and CLINCK Cyber Café Manager, to add rate plans, to 

add customers, to provide services to the customers like print, scan, selling of pen drives, CDs etc, to assign 

permissions to employees, to take backup and restore the system. The various tabs, their purpose, usage and 

examples are explained in detail to help the user efficiently use CLINCK.  

 

1.2 Intended Audience 
 

This guide is intended for a person with minimal knowledge of computers, who will allow customers to log in, 

purchase a product or service, maintain reports, generate bills, and log out the customers. 

 

1.3 Conventions Used 
 

Convention Explanation 

Bold For field, menu, option and window names. 

Arial  For commands as you should type them. 

Arial For output as generated by the system. 

Italics For note and URLs.  

 
Note 

The note icon indicates information that is of special interest or 

importance, for example, an additional action required only in 

certain circumstances. 

 
Caution 

The Caution icon along with the text indicates actions that can lead 

to damage if the instructions are not followed properly. 

Table 1.1: Conventions Used in the User Guide 
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1.4 Revision History 
 

This is the first version of the CLINCK Cyber Café Manager user guide. 

 

1.5 Introduction to CLINCK Cyber Café Manager 
 

The CLINCK Cyber Café Manager application is made up of two parts – the server and the client. While the 

application is managed from the server, the cyber café’s services such as internet usage and printing are provided 

at the client terminals.  

 

1.5.1 CLINCK Server 
 

All the features and functions of the CLINCK Cyber Café Manager are available under the different tabs that appear 

on the CLINCK server screen. Each of these tabs is explained briefly here. 

 

 

 

Figure 1.1: Tabs on the CLINCK Server screen 

 

CLINCK Server Tabs
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Note: In addition to a brief introduction here, all these tabs are discussed in detail in other chapters 

of this user guide. 

 Home 

 

The Home tab takes you to the home page. It mainly consists of the Quick Access Menu, the Terminals Pane, the 

Updates Pane, Quick Help, and Terminal Information. 

 

The following tasks are available under this tab: 

 Add or find a customer in the CLINCK database. 

 Add a product or service sale to the database. 

 Shutdown, restart, or re-connect all terminals. 

 Generate the Daily Register, Collection, and Terminal Usage reports. 

 

 

Note: For more information on the home page, see Chapter 4. 

 

 Customers 

 

In the Customers tab, you can manage your cyber café’s customer details and create customer-related reports.  

 

The following tasks are available under this tab: 

 Add, view, edit, or delete a customer’s details in your cyber café’s CLINCK database. 

 Find an existing customer in your cyber café’s CLINCK database or in the online CLINCK database. 

 Import a customer from the online CLINCK database to your cyber café’s CLINCK database. 

 Convert a customer to a member and view a customer’s membership details. 

 Generate the Daily Register, Customer List, Customer History, Member List, and Member History reports. 

 

 

Note: For more information on customer-related tasks, see Section 5.3. 

 

 Rate Plans 

 

In the Rate Plans tab, you can manage your cyber café’s rate plans and membership packages and create related 

reports.  

 

The following tasks are available under this tab: 

 Add, edit, or delete a rate plan in your cyber café’s CLINCK database. 

 Add, edit, or delete a membership package in the database. 

 Generate the Member List and Member History reports. 

 

 

Note: For more information on rate plans, see Section 5.1, and for more information on membership 

packages, see Section 5.2. 
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 Products & Services 

 

In the Products & Services tab, you can manage your cyber café’s product and service details and create related 

reports.  

 

The following tasks are available under this tab: 

 Add, edit, or delete the details of a product or service in your cyber café’s CLINCK database. 

 Add a product or service sale in the database. 

 Generate the Product List, Purchase, as well as Product and Service Consumption reports. 

 

 

Note: For more information on tasks related to products and services, see Chapter 6. 

 

 Employees 

 

In the Employees tab, you can manage your cyber café’s employee details and create employee-related reports.  

 

The following tasks are available under this tab: 

 Add, edit, or delete an employee’s details in your cyber café’s CLINCK database. 

 Generate the Close Café Client report. 

 

 

Note: For more information on employee-related tasks, see Chapter 12. 

 

 Print Manager 

 

In the Print Manager tab, you can manage printer settings and create printer-related reports.  

 

The following tasks are available under this tab: 

 Change printer settings. 

 Generate the Printer Usage and Printer Summary reports. 

 

 

Note: For more information on printer-related tasks, see Chapter 9. 

 

 Auto Server Mode 

 

In the Auto Server Mode tab, you can set the CLINCK Cyber Café Server to take your place in your absence. When 

the Auto Server Mode is on, a walk-in customer can directly login from an idle terminal and start a session even 

without registering in the CLINCK database. When the customer logs out, the server automatically closes the 

session and the billing information of the session is displayed in the tab. 
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The following tasks are available under this tab: 

 Change auto server mode settings. 

 Add a customer’s details to your cyber café’s CLINCK database. 

 Add a product or service sale to the database. 

 Add or edit a rate plan in the database. 

 Generate the Daily Register, Collection, and Terminal Usage reports. 

 

 

Note: For more information on auto server mode settings, see Chapter 10. 

 

 Reports 

 

In the Reports tab, you can generate and view many different reports that fall in the following categories: 

 General Reports 

 Financial Reports 

 Customer Reports 

 Café Management Reports 

 Product & Service Reports 

 Printer Reports 

 

 

Note: For more information on reports, see Chapter 11. 

 

 How To Start 

 

The How To Start tab has a 3-step guide that shows how to start using the CLINCK Cyber Café Manager.  

 

The following help options are also available under this tab: 

 Online Help 

 FAQ 

 Contact Us/Live Support 

 

 

Note: For more information on the 3-step guide and other help options, see Chapter 13. 

 

1.5.2 CLINCK Client 
 

The CLINCK Client screen is called the CLINCK Desktop. In addition to the regular desktop, it has internet shortcuts, 

content, Google search, and brand promotions to make the customer's internet session easy and interesting. 
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Figure 1.2: CLINCK Client screen 

 

Google Search Bar Tabs with content 

Regular Desktop 

Quick Links 
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2.  

 

 

 

 

 

 

 

Chapter 2: Installation 

 

2.1 System Requirements 

 

CLINCK Cyber Café Manager is an easily installable software which does not require major changes to your 

hardware or software. Your present network setup is just fine to run CLINCK. CLINCK utilizes system to a minimum, 

to ensure that the clients are not overburdened. CLINCK installation (both server and client) is a simple process. 

 

The basic system requirement to install CLINCK is as shown in Table 2.1: 

 

Specifications Server Client 

Installer Size 27.6 MB 5.51MB 

Operating System Windows XP(SP2) Windows XP/2000 

Internet connection Required Required 

Processor(minimum) 1.5 GHz and above 800 MHz 

Hard Disk 290 MB 5 MB 

RAM(minimum) 512 MB 128 MB 

Internet Explorer Version IE 6.0 onwards IE 5.5 onwards 

Deep Freeze compatibility Yes Yes 

Time to install 15 minutes 1 minute 

 

Table 2.1: Basic System Requirement 

 

The server and client screen, a customer can view are as shown in Figure 2.1 and Figure 2.2. 
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Figure 2.1: CLINCK Cyber Café Manager 
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Figure 2.2: CLINCK Cyber Café Client 

2.1.1 Additional Important Requirements 
 Firewall: 

 

Firewall is software that runs on a computer and inspects network traffic passing through it. It is located at the 

Gateway Server and protects the private network resources from the users of the other networks. A firewall’s basic 

task is to regulate the flow between computer networks of different levels. 

 

 If you have Windows Firewall installed in your network, you may see the following dialog box on starting 

CLINCK Cyber Café Manager.  

 
Figure 2.3: Windows Security Alert 
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Result: When Unblock is selected, you can proceed with the installation of CLINCK Client. 

 

 If you use any other firewall in your network, then you must manually add CLINCK Cyber Café to the 

exception list. To do so, first locate the file - CCMUI.exe from the folder where source files of CLINCK Cyber 

Café Manager is stored.  

• CCMUI.exe 

 Regional and language setting: 

 

Set the regional setting of your system to English (United States). 

In Windows, this is the default setting but you must check and confirm.  

 

To set the regional settings for your system, follow the steps given below: 

 

1) Select Start > Settings > Control Panel.  

 

Figure 2.4: Select Control Panel 

 

The Control Panel window appears as shown in Figure 2.5.   
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Figure 2.5: Control Panel 

2) In the Control Panel, select Date, Time, Language, and Regional Options.  

      The Date, Time, Language, and Regional Options window appears. 

 
Figure 2.6: Date, Time, Language, and Regional Options 
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3) In the Date, Time, Language, and Regional Options window, select Regional and Language Options. 

      The Regional and Language Options dialog box appears. 

 

 

Figure 2.7: Regional and Language Options 

 

4) In the Regional Options tab, do the following: 

 In the Standards and formats box, select English (United States).  

 Click Customize.  

      The Customize Regional Options dialog box appears. 
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Figure 2.8: Customize Regional Options 

 

5) Click the Date tab. The Date tab opens. 

 In the Short date format box, select MM/dd/yyyy. 

 In the Date separator box, select “/”. 

 Click OK.  

The Customize Regional Options dialog box closes and the Regional and Language Options dialog box opens. 

6) Click OK. 

 

Result: The Regional Language is set to English and the Date Format is set to mm/dd/yyyy. 

 

2.2 Setup 
 

2.2.1 To Install CLINCK Cyber Café Manager 
 

CLINCK Cyber Café Manager helps in better Café Management and Accounting.  

 

The minimal hardware requirements to install CLINCK Cyber Café Manager are: 

 512 MB RAM 

 1.5 GHz Processor 
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The minimal software requirements to install CLINCK Cyber Café Manager are: 

 Internet Explorer version 6 

 Service Pack 2 of Windows XP 

 

To install CLINCK Cyber Café Manager, do the following: 

 

1) Register as a partner with Ideacts, http://www.ideacts.com/cms/partner/NewCafeRegistration.aspx 

2) Ideacts mails you the Café code and Password to activate the café. 

3) After activating the cafe, login to Ideacts with http://www.ideacts.com/CMS/partner/Login.aspx 

4) Download the Installation Manuals for both CLINCK Cyber Café Manager and CLINCK Cyber Café Client. 

5) Download Installers for Server Copy and Client Copy. 

6) Install CLINCK Cyber Café Manager using Server Copy. 

7) To open CLINCK Cyber Café Manager Server, do the following: 

 

 Click Start > Programs > Ideacts > CLINCK Cyber Café Manager Server. 

 

 
Figure 2.9: To open CLINCK Cyber Café Manager Server 

 

The CLINCK Cyber Café Manager Server opens. 

 

When CLINCK is installed for the first time, a Setup Wizard – Welcome Screen is displayed as shown in Figure 2.10.  
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Figure 2.10: Setup Wizard - Welcome Screen 

 

8) The Setup wizard comprises of three steps: 

1. Activating the CLINCK Cyber Café Manager. 

2. Creating Rate Plans. 

3. Setting the Café Terminals. 

 

On the Setup Wizard - Welcome Screen, click Next.  

The Setup Wizard [Step 1] - Activation screen opens. 
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Figure 2.11: Setup Wizard [Step 1] - Activation 

 

1. Activating the CLINCK Cyber Café Manager: 

 

 

Note: 

� Café code is required for activation. 

� If you do not have a Café Code, register as a partner with Ideacts, to get the Café Code and 

Password. 

 

 Register as a partner with Ideacts, http://www.ideacts.com/cms/partner/NewCafeRegistration.aspx 

 Ideacts mails you the Café code and Password to activate the café. 

 

a. Enter the Café Code and click Verify.  

                    On Verification, Café Name and Café Address are displayed on the screen. 
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Figure 2.12: Setup Wizard - Activation 

 

 

Note: 

� IIPL Employee No. is left blank, for a café owner. 

� IIPL Employee No. is filled, when the installation is done by an Ideacts employee. 

 

b. Click Next to proceed with activation. 

                    When the activation is done successfully, a dialog box opens, informing about the successful activation.  

 

 
Figure 2.13: Setup Wizard – Successful activation 

 

c. Click OK.  

 

Result: The window for Rate Plan creation opens. 
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Figure 2.14: Setup Wizard [Step 2] - Rate Plan 

 

2. Creating a Rate Plan: 

 

To create a Rate Plan, do the following: 

a. Duration (From), the default is zero minutes. 

b. In the Duration (To) box, select the minimum duration that you want to set. For Example: 30 minutes. 

c. Enter Price based on duration. 
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Figure 2.15: Setup Wizard - Adding a Rate Plan 

 

d.  Click Add.  

         The Rate Plan is added as shown in Figure 2.16. 
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  Figure 2.16: Setup Wizard - Rate Plan 

 

e. Click Next. 

Result: The Client setup screen opens. 
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Figure 2.17: Setup Wizard - Client Setup 

 

3. Setting the Café terminals: 

 

 

Note: 

� When CLINCK is installed for the first time, download and install CLINCK Cyber Café Client on all the 

terminals, from http://partners.ideacts.com. 

� When you are already using CLINCK in your Café, then on the Client terminal, right-click on CLINCK 

icon found on the system tray, and select “Enable CLINCK Cyber Café Client”. 

 

 Click Next. 

Result: Setup Wizard – Finish screen opens. 
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Figure 2.18: Setup Wizard – Finish 

 

4. Click Finish. 

             The Server Login dialog box opens. 

 

 
Figure 2.19: Server Login 
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5. Enter default login details for Employee Name as “admin” and Password as “password”. 

 

 
Figure 2.20: Server Login with default values 

 

6. Click Login. 

 

Result: The How To Start tab opens as shown in Figure 2.21. 
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Figure 2.21: Setup Wizard - How To Start 

 

7. To view each step in detail, refer to Figure 2.21: 

 Click Step1 

 Click Step2 

 Click Step3 

 

8. Click Home. 

             Manage Terminals screen appears. 
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Figure 2.22: Home – Manage Terminals 

 

Result: CLINCK Cyber Café Manager is installed successfully.  

 

2.2.2 To Install CLINCK Client 
 

There are two flows to install CLINCK Cyber Café Client: 

 

 For users who directly download CLINCK with the Cyber Café Client. It is done by using the Wizard setup 

application. 

 For users who were using old version of CLINCK, installation is done by “Enable CLINCK Café Client” on the same 

system. 

 

  Minimum Software Requirements: 

 Microsoft Windows 2000 and Windows XP 

 Internet Explorer 5.5 

 

  Minimum Hardware Requirements: 

 RAM 128 MB 

 Processor 800 MHz 

Downloading the CLINCK Installer: 
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1) Log on to http://partners.ideacts.com 

2) Enter Username and Password 

3) Download the latest CLINCK Installer from the Installers Section in the website and extract the CLINCK    

Installer. 

 

 

Figure 2.23: CLINCK – Client Installer 

 

Preparing to run CLINCK Client:  

 

1) Connect the machine to the internet, to activate the terminal during setup. 

2) Select the drive that has sufficient free space.  

3) To install CLINCK you need the following disk space: 

 

 Minimum 5 MB free space on the System drive. In a default Windows Setup, the system drive is C: 

 5 MB free space on the drive, where you choose to install CLINCK  

 

Installing CLINCK Client: 

 

1) Run the setup from the location you extracted it. 
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Figure 2.24: Preparing Setup 

 

 
Figure 2.25:  Preparing setup final stage 

 

As the Wizard prepares for the setup, the Welcome screen opens.  
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Figure 2.26: Welcome Screen 

 

2) Click Next  

Choose Destination Location dialog box appears. 

 

 
Figure 2.27: Choose Destination Folder 
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3) Click Browse, to install CLINCK in a different folder apart from the default C: drive. 

4) Click Next.  

The Setup will copy all required files for installation. 

 

 
Figure 2.28: CLINCK InstallShield Wizard 

 

5) Select Yes to Enable CLINCK Cyber Café Client, after the setup finishes copying the files.  

 
Figure 2.29:  CLINCK – InstallShield Wizard 
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6) Click Next to complete the installation. 

 
Figure 2.30:  CLINCK – InstallShield Wizard 

 

7) Click Finish.  

   

 
Figure 2.31:  CLINCK – InstallShield Wizard 

 

 

Note: 

� Reboot the system for the setup to complete the installation process. 

� Login as an Administrator to activate the terminal before you start using CLINCK. 

 

 

 

Result: CLINCK Cyber Café Client installation is complete. 
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2.2.2.1 Activating CLINCK Client Terminal 
 

As you complete the Installation, each terminal must be activated. Each terminal is given a unique code, which you 

can use to identify the terminal in your partner account reports. 

 

The steps to activate your terminal are as follows: 

1) Enter Cyber Café Code. 

2) Click Verify.  

 

The system will fetch your cafe details (name and address) from the CLINCK server and displays it in the section 

below. Verify that your café name and address is correct. 

 
Figure 2.32: CLINCK Activate Terminal 

 

3) Click Next to activate the terminal. 

 

 

Note: 

� IIPL Employee No. is left blank, for a café owner. 

� IIPL Employee No. is filled, when the installation is done by an Ideacts employee.  

 

Result: The activation is complete and CLINCK will start automatically displaying the Café Name, towards the left 

top of the screen. 
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At this point, the client application starts, and looks forward for the server on the network. If it finds the server, it 

connects to it and displays the café name and other information on the left top of the following window. And if it 

does not find the server, it will remain in the disconnected state and connects to the server automatically when it 

starts. 

 

          

                                               
 

 
                                                                                                                                            

         

                                             

Figure 2.33:  CLINCK Activate Terminal 

 

Result: The CLINCK Cyber Café Client is automatically enabled. 

 

 

2.2.3 To Install CLINCK Client with Deep Freeze 
 

Faronics’ Deep Freeze is a software application which freezes your system so that any changes made will not be 

permanent. It provides immediate immunity from many of the problems that affect computers today. When the 

system becomes unstable for reasons like virus, driver misconfigurations, then you simply need to reboot it. Deep 
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Freeze restores the system to the state; it was in when last frozen within a few seconds. 

 

Downloading CLINCK Client with Deep Freeze Installer: 

 

1) Log on to http://partners.ideacts.com 

2) Enter your Username and Password. 

3) Download the latest CLINCK with Deep Freeze Installer from the “Downloads” section in the website.  

 

 
Figure 2.34: CLINCK Deep Freeze Installer 

 

Now, Deep Freeze is part of your CLINCK with Deep Freeze Installer, and if you choose to install / uninstall CLINCK 

on a terminal, Deep Freeze will also automatically get installed / uninstalled. 

 

Preparing to run CLINCK Client with Deep Freeze Setup Application: 

 

1) Connect the machine to the internet to activate the terminal during setup. 

2) Select the drive that has sufficient free space. To install CLINCK Client with Deep Freeze you need the following 

disk space: 

 Minimum 5 MB free space on the system drive. In a default Windows setup, the system drive is C: 

 5 MB free space on the drive, where you choose to install CLINCK Client with Deep Freeze. 

3) Uninstall any previous version of Deep Freeze that may be installed on the machine.  

 

Note: 

� It is strongly recommended that you install CLINCK Client with Deep Freeze on a formatted 
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machine, because the system will return to a clean state each time it is restarted. 

� Do not install Deep Freeze on a machine that is virus infected or has disk problems because it will 

result in an issue after every start. 

Installing CLINCK Client with Deep Freeze: 

 

1) Run the CLINCK set up from the location where it is extracted. 

 

Figure 2.35: Preparing Setup 

 

 

Figure 2.36: Preparing setup - Final stage 

 

As the Wizard prepares for the setup, the Welcome screen appears.  
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Figure 2.37: Welcome screen 

 

2) Click Next. 

The folder selection dialog box appears. 

 

Figure 2.38: Choose Destination Location 

 

3) Select the folder location where you want to install CLINCK. 

4) Click Next in the Choose Destination Location dialog box. 

 

      The Deep Freeze drive selection dialog box appears. 
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Figure 2.39: List of Fixed Drives that user can select 

 

5) Select drives that you want to keep frozen while installing Faronics Deep Freeze. 

      The Setup will copy all the required files.  

                  

Figure 2.40: Installing files required to run CLINCK 

 

6) Select Yes to Enable CLINCK Cyber Café Client, after the setup finishes copying the files. If you use CLINCK Cyber 

Café Manager in your café, choose the option provided here.  
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Figure 2.41: Enable CLINCK Cyber Café Client 

7) Click Next to complete the installation. 

8) Activate the terminal before Faronics Deep Freeze is installed. 

9) Click Next. 

      The activation screen appears. 

 

Figure 2.42: Terminal Activation Screen 
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10) Enter your café code that was mailed to you during café registration for activating the terminal and registering  

with the CLINCK server. 

 

The CLINCK Client with Deep Freeze installation is complete after the activation is completed.    

The setup now installs Faronics Deep Freeze. 

 

 

Note: You must close all applications and save all work before you click FINISH button because the 

install automatically restarts the machine after Deep Freeze installation is complete. 

 

Deep freeze setup starts automatically after the CLINCK setup has finished.  

 

Figure 2.43: Deep Freeze Setup 

11) Set a Deep Freeze password after the machine restarts. 

       The following screen appears automatically.          

 

Figure 2.44: Deep Freeze Set Password 

After setting the Deep Freeze password you will gain access to the Deep Freeze. 

 

Result: The CLINCK Cyber Café Client is installed with Deep Freeze. 

 

Note: Save your Deep Freeze password in a safe location where you can find it easily. The password 

is set only once and your machine cannot be unlocked without it. 
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3.  

 

 

 

 

 

 

 

Chapter 3: Configuration 
 

 

3.1 To Configure the Server 
 

 

3.1.1 To Configure the Network 
 

 

Note: Please read this section only if you use a dual LAN configuration. 

If the network has a dual LAN configuration, after the installation of the CLINCK Cyber Café Server and Client, the 

following screen appears with only one or no client terminals connected.  

 
Figure 3.1: Home - No terminals connected 
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CLINCK Cyber Café Manager cannot work with a dual LAN network. As a dual LAN network configuration has the 

following: 

 Two different networks 

 Two different IP ranges 

 Two switches not connected to each other 

 Two different Internet Service Providers (ISPs) 

 One Server 

This is as shown in Figure 3.2. 

 

Figure 3.2: A dual LAN network 

An application like CLINCK Cyber Café Manager, works on a single network, by using one IP range. This is as shown in 

Figure 3.3 and Figure 3.4. Such a network has the following configuration: 

 All the terminals must be of the same IP range. 

 All the terminals must be connected to a common switch, as shown in Figure 3.3. 

 All switches in a large network must be connected to each other, as shown in Figure 3.4. 

Both the figures, Figure 3.3 and Figure 3.4 are perfect enough for CLINCK Cyber Café Manager to work successfully. 

 

Figure 3.3: Small network with only one switch 
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Figure 3.4: Large network with several switches 

 

Result: The network is configured. 

 

3.2 To Configure CLINCK Client 
 

1) Click Start > All Programs > CLINCK > Start CLINCK Cyber Café Client.  

 
Figure 3.5: CLINCK - CLINCK Cyber Café Client 
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The CLINCK Client login screen opens. 

 

 

Figure 3.6: CLINCK Client Login 

 

Result: CLINCK Cyber Café Client is configured successfully. 
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4.  

 

 

 

 

 

 

 

 

 

Chapter 4: Home Page 
The home page of the CLINCK Cyber Café Server helps the user to quickly perform his day to day tasks. All the 

frequently used options are provided in the home page. The home page is divided in to the following panels as 

shown in Figure 4.2: 

 

 Terminals Pane 

 Updates Pane 

 Terminal Information 

 Quick Access Menu 

 Quick Help 

 

Each of these panels is discussed further in this chapter. 

 

In addition to the five main sections listed above, the following two sections provide some additional information 

on the home page: 

 

 Login Details 

 

This section displays the CLINCK server’s login information, including the cyber café’s name, the café code, and 

the logged in employee’s name. 

 

 Date & Time 

 

  This section displays the current date, day, and time. 

 

  When no terminals are set up as a CLINCK client, the home page appears as follows: 
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Figure 4.1: Home page, without terminals 

 

When the CLINCK client application is installed on any terminal in your cyber café’s computer network, the home 

page appears as follows: 
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Figure 4.2: Home page, with terminals 

 

The rest of the chapter discusses the five main sections of the home page in detail. 

 

4.1 Terminals Pane 
 

The Terminals Pane displays all terminals serving as a CLINCK Cyber Café Client on your computer network and 

allows you to manage them. It also shows the following information related to the terminals in a summary section 

at the bottom: 

Terminals Pane 

Quick Help 

Quick Access Menu 

Updates Pane Terminal Information 

Date & Time 

Login Details 
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 Total number of terminals 

 Number of connected terminals 

 Number of disconnected terminals 

 Number of busy terminals 

 Number of idle terminals 

If no terminals are connected to the CLINCK Cyber Café Server, the Terminals Pane appears as follows: 

 
Figure 4.3: Terminals Pane, without terminals 

After terminals on your computer network are set up as CLINCK clients, they are displayed in the Terminals Pane 

and a summary section shows information about them at the bottom. 

 
Figure 4.4: Terminals Pane, with terminals 

4.2 Updates Pane 
The Updates Pane has two tabs: 

 Closed Sessions 

 Event Log 

4.2.1 Closed Sessions 
 

The Closed Sessions tab is updated whenever a customer logs out from a terminal and the session is closed.  
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The following information is displayed in the tab every time a session is closed on a client terminal: 

 Customer Name – Name of customer who logged out 

 Customer Type – Type of customer 

 Terminal Name – Name of terminal 

 Time In – Login time (or session start time) 

 Time Out – Logout time (or session end time) 

 Duration – Duration of session 

 Total Amount – Total amount charged to the customer for the internet session 

 Bill/Invoice Details – Link to detailed invoice for the internet usage 

 

Note: 

� A bill/invoice is automatically generated when a customer logs out and a session is closed at a 

terminal. In the Closed Sessions tab, click View Details… to see the bill details. 

� In the Closed Sessions tab, click the down arrow next to Time Out to change the order of the 

closed sessions to ascending or descending. 

 

 

Figure 4.5: Closed Sessions tab 

4.2.2 Event Log 

The Event Log tab displays a record of events that occur on the terminals, such as when a customer logs in or logs 

out on a terminal. The following information is displayed in the tab every time an event takes place: 

 Terminal Name – Name of the terminal where the event took place 

 Date Time – Date and time of the event 

 Message – Message describing the event 

 

Figure 4.6: Event Log tab 

4.3 Terminal Information 
 

The Terminal Information section of the home page displays information related to a terminal selected in the 

terminals pane. This includes the following: 

 Status of the terminal (connected/disconnected) 

 Name of the terminal 

 Name and type of customer using the terminal 

 Login and logout time of the customer at the terminal 

 Duration of terminal usage 

 Internet usage charges 

 Charges for any other products or services purchased 

 Total amount charged to the customer 

 Time remaining for the terminal session to end 
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Figure 4.7: Terminal Information 

4.4 Quick Access Menu 

 

The Quick Access Menu gives you the most frequently needed features of the CLINCK Cyber Café Manager from the 

home page itself. The user does not have to navigate to other Menu Bar tabs under which these features are also 

available. The Quick Access Menu is divided into the following three categories: 

 Common Tasks 

 Add New Registered Customer 

 Find Customer 

 Add a Product/Service Sale 

 Related Reports 

 Daily Register Report 

 Collection Report 

 Terminal Usage Report 

 System Tools 

 Shutdown All Terminals 

 Restart All Terminals 

 Re-connect All Terminals 

 
Figure 4.8: Quick Access Menu 

Each of the Quick Access Menu options is explained briefly in this section. 

4.4.1 Common Tasks 
 

This section of the Quick Access Menu provides links to the most commonly used tasks of the CLINCK Cyber Café 

Manager. 
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Figure 4.9: Common Tasks on the Quick Access Menu 

4.4.1.1 Adding a New Registered Customer 
This option allows you to add a new registered customer to your cyber café’s CLINCK database. 

 

Note: For a detailed explanation on how to add a new registered customer, see Section 5.3.1.2 of 

this user guide. 

4.4.1.2 Finding a Customer 
This option allows you to find an existing customer in your cyber café’s CLINCK database or in the online CLINCK 

database. It also lets you view, edit, and delete customer details, as well as convert customers to members and 

view their membership details. 

 

Note: For a detailed explanation on how to find a customer, see Section 5.3.2 of this user guide. 

4.4.1.3 Adding a Product/Service Sale 
This option allows you to add a product or service sale to your cyber café’s CLINCK database. 

 

Note: For a detailed explanation on how to add a product or service sale, see Section 6.4 of this user 

guide. 

4.4.2 Related Reports 
This section of the Quick Access Menu provides links to the most commonly used reports of the CLINCK Cyber Café 

Manager. 

 
Figure 4.10: Related Reports on the Quick Access Menu 

4.4.2.1 Daily Register Report 
The Daily Register Report gives details of all the customers who visited your cyber cafe on a specific date. 

 

Note: For more details on the Daily Register Report, see Section 11.1.1 of this user guide. 

4.4.2.2 Collection Report  
The Collection Report gives details about the money earned on a specific date or during a longer time frame. It lists 

each financial transaction that took place within the given time range, including internet usage and the sale of 

products and services. 

 

Note: For more details on the Collection Report, see Section 11.2.1 of this user guide. 

4.4.2.3 Terminal Usage Report 
The Terminal Usage Report gives details about which terminal is being used how many time by customers. 
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Note: For more details on the Terminal Usage Report, see Section 11.4.1 of this user guide. 

4.4.3 System Tools 
This section of the Quick Access Menu provides links to the most basic system tools needed to run the CLINCK 

Cyber Café Manager. 

 

Figure 4.11: System Tools on the Quick Access Menu 

4.4.3.1 Shutdown All Terminals 
This option allows you to shutdown all terminals together. 

 

Note: For more details on how to shutdown all terminals, see Section 7.11 of this user guide. 

4.4.3.2 Restart All Terminals 
This option allows you to restart all terminals together. 

 

Note: For more details on how to restart all terminals, see Section 7.12 of this user guide. 

4.4.3.3 Re-connect All Terminals 
This option allows you to re-connect all terminals together. 

 

Note: For more details on how to re-connect all terminals, see Section 7.13 of this user guide. 

4.5 Quick Help 
The Quick Help section of the home page provides explanations and instructions related to CLINCK Cyber Café 

Manager’s frequently used features and tasks appearing on that page.  

 

Note: Quick Help changes according to the screen. A different Quick Help section appears under 

every tab of the menu bar and offers guidance specifically related to the particular tab and its 

functions. 

 

Figure 4.12: Quick Help on the home page 
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Chapter 5:  Rate Plans and Customers 
 

5.1 Rate Plans          
  

Rate Plan is a fixed amount which the café charges a customer for browsing the internet. The rate plan is set based 

on the time. For instance, Rate Plan can be set as Rs. 10 for 30 minutes and Rs. 15 for 60 minutes, and so on.   

 

5.1.1 To Create a Rate Plan      
 

You can create rate plans using the Rate Plan tab on the main menu.  

To open the Rate Plan dialog box, do the following: 

 

1) On the Rate Plans tab, click Add/Edit Rate Plan. 

 

The Rate Plan dialog box opens as shown in Figure 5.1. 
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Figure 5.1: Rate Plans – Add/Edit Rate Plan 

 

2) In the Rate Plan dialog box, do the following: 

 

      1. Duration (From), the default is zero minutes. 

      2. In the Duration (To) box, select the minimum duration that you want to set. For example:    

          30 minutes. 

3. Enter Price based on the duration. 

Rate Plan dialog box 
Rate Plans tab 

Rate Plans Related Reports 
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Figure 5.2: Rate Plan 

3) Click Add. 

      The Rate Plan is added successfully as shown in Figure 5.3. 

 
Figure 5.3: Add/Edit Rate Plan 

 



60   |   Chapter 5 

             

              

              

               60                  

 

4) Click Save.   

      Rate Plan is created as shown in Figure 5.4. 

 

 

 
Figure 5.4: To view the added Rate Plan 

 

 

Note: Rate Plans tab has the following reports: 

� Member List Report, see section 11.3.5 

� Member History Report, see section 11.3.4  

For more information on these reports, see Chapter 11. 

 

Result: The Rate Plan is created successfully. 

 

5.2 Membership Package 
 

Membership Package is a scheme, which offers customers huge Internet minutes, for a specific discount. For 

example, the cost of internet usage is Rs. 15/Hr for a Walk-In Customer. But for a member, the cost is Rs. 95/10 Hrs, 

along with a validity of 30 days.  

A customer becomes a member of the café by buying a Membership Package. 

 

To create a Membership Package, do the following: 

1) On the Rate Plans tab, click Add New Package. 

Newly added Rate Plan 
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Figure 5.5: Rate Plans – Add New Package 

         Add/Edit Membership Package dialog box opens. 

 

Figure 5.6: Add/Edit Membership Package 

2) In the Add/Edit Membership Package dialog box, do the following: 

 

 Enter Name and Description of the package. 

 Enter Minutes, Price (Rs.) and Valid for (Days). 

 Enter Expiry Days.  
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Figure 5.7: Add Membership Package 

 

3) Click Save. 

Result: Membership Packages list opens as shown in Figure 5.8. 

 

 

Figure 5.8: Membership Packages 

Rate Plans Related Reports 
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Note:  

� You can create any number of membership packages. 

� A plan cannot be deleted if a customer has already taken the plan.     

� If a member logs into a session, for each passing minute, he is charged.   

� After logout, the member is not charged. 

� Rate Plans tab has the following reports: 

▫ Member List Report 

For more information on these reports, see Chapter 11. 

 

5.2.1 Pulse Based Membership 
 

In a Pulse Based Membership, predefined minutes are reduced from the member’s package.  

For example, if the pulse time entered is 5 minutes, this implies, 5 minutes is 1 pulse. For each pulse (every 5 

minutes), deduction takes place in the member’s package.  

 

To activate Pulse Based Membership, do the following: 

 

1) Click File > Application Settings > Rate Plans. 

 The Rate Plans tab of Application Settings opens. 

 

Figure 5.9: Application Settings – Rate Plans 

2) In the Rate Plans - Application Settings dialog box, do the following: 

1. Select Enable Pulse Based Membership.  
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2. Enter the Pulse Time. 

3) Click OK. 

 

Result: Pulse Based Membership is activated.  

 

 

Note:  

� When Pulse Based Membership is enabled, the café host performs “Close Session”, even for 

Registered Members.  

� Member Re-login is activated by selecting pulse based membership. 

 

5.3 Customers                               
 

Customers of a cyber café are the public who visit the cafe to access Internet. Three types of customers can be 

created in CLINCK Cyber Café Manager, namely: 

 

 Walk-In Customers  

 Registered Customers 

 Registered Members 

5.3.1 To Register Customers 
 

5.3.1.1 Walk-In Customers: 
 

A customer who directly walks into the cyber café without registering any details is a Walk-In customer.  

To Login as a Walk-In customer, do the following: 

 

1) On the CLINCK Cyber Café Manager Home page, select an idle terminal where you want the customer to sit and 

right click the mouse button. 

2) Select Login as Walk-In as shown in Figure 5.10. 
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Figure 5.10: Login as Walk-In 

      The Walk-In Customer Login dialog box appears.       

 
Figure 5.11: Login as Walk-In 

 

3) On the Walk-In Customer Login dialog box, do the following: 

 Enter the Customer Name and Address.  

 Select the ID Card Type. 

Idle terminal 
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 Enter the ID Card No. 

 Enter the Set Session Time. 

4) Click Login. 

 

Result: The customer logs in as a Walk-In Customer on the selected terminal. 

 

If a Walk-In customer logs out from the Client terminal, the café host can re-login the customer with the following 

steps: 

 

1) Right click must be done on the terminal where the customer was sitting. 

2) Click Re-Login as Walk-In, as shown in Figure 5.12. 

                    

Result: The customer is now logged in again. 

 

Figure 5.12: Re-Login as Walk-In 

 

5.3.1.2 Registered Customers: 
A customer must register only once with the CLINCK Cyber Café Manager, by providing all the necessary details.  

 

With the Login ID and Password, got from CLINCK Cyber Café Manager, the customer must login to CLINCK Cyber 

Café Client, to activate the account.  

 

Once the activation is done, the customer can access CLINCK, using the All-India single Login ID from any of the 

CLINCK cafes. 

 

To add a Registered Customer, do the following: 

 

1) On the Customers tab, click Add New Registered Customer as shown in Figure 5.13.   
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Figure 5.13: Add New Registered Customer 

 

             Add /Edit Customer dialog box opens as shown in Figure 5.14. 

Add New Registered Customer 
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Figure 5.14: Add or Edit Customer 

2) To add a customer, do the following: 

 Enter Customer Name.  

 The Temporary Login ID is generated automatically. 

 Click the appropriate Gender. 

 Enter Address and numeric Contact No.  

 For the Customer Picture or Photo ID, do the following: 

a. Click Start Webcam.  

b. Ask the customer to stand in front of the Webcam and focus to take a picture. 

c. Click Take Picture, to capture the photograph. 

d. Click Browse, to select the photograph that is saved as an image on the system.  

 

Note: Step ‘d’ is optional if a webcam is not available. 

                    So, the user needs to take a picture or select a picture already saved on the system. 
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Figure 5.15: Add a Registered Customer 

 

3) Click Finish. 

    

The customer is now added to the Café Database. 

 

Now the system shows temporary login details of the customer, which is as shown in Figure 5.16. 

 

Figure 5.16: Temporary login details of the Customer 
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4) Automatic Customer Login: 

CLINCK Cyber Café Manager automatically assigns an idle terminal to the Customer. 

Hence, the customer can directly login to the assigned terminal. 

5) Click OK. 

 

The Manage Terminals window opens, displaying the assigned terminal, along with the Customer Name. 

 

 

 

 
Figure 5.17: Manage Terminals 

 

6) With the temporary login details as in Figure 5.16, customer must login CLINCK Cyber Café Client and complete 

the registration process, by providing the following details: 

 

 Enter a valid Email.   

 Enter the Login ID.  

 Enter the Password. 

 Retype the Confirm Password. 

 Select a Security Question. 

 Enter the Security Answer. 

 Select I agree to the terms and conditions. 

Customer Name and Terminal 
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Figure 5.18: Customer Registration 

 

7) Click Submit. 

 

Result: Customer Registration is completed. 

 

5.3.1.3 Members Only: 
      

To convert a Registered Customer to a Registered Member, do the following: 

  

1) On the Customers tab, click Show All Customers Of My Cafe. 

     Registered Customer List opens as shown in Figure 5.19. 
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Figure 5.19: Registered Customer List 

 

2) Select the customer whom you want to sell the package to. 

3) Click Convert to Member. 

Registered Customer 
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Figure 5.20: Registered Customer List – Convert to Member 

 

Convert To Member dialog box opens. 
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Figure 5.21: Convert to Member 

 

 

Note: If no membership packages are defined, then create a new membership package by referring 

to Section 5.2 Membership Package. 

4) To change a customer to a member, do the following: 

 Customer Name, the default is the customer name. 

 Select Membership Package.  

 

Note: If a Membership Package is not selected, then Minutes, Valid For (Days), Price and Expiry 

Days fields cannot be edited. 

 Enter Minutes, Valid For (Days), Price and Expiry Days. 

 

Note: Carry forward existing minutes can be used when a member is unable to use the remaining 

minutes of the package within its validity period. These remaining minutes can be carried forward to 

the new package. 

 Select Carry forward existing minutes. 

 Enter Minutes to carry forward. 

 

Note: For a customer who becomes a member for the first time, Carry forward existing minutes is 

not selected. 
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Figure 5.22: Convert to Member 

 

5) Click Pay. 

      Registered Customer List opens as shown in Figure 5.23.  
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Figure 5.23: Registered Customer List – Registered Member 

 

Result: Now the Registered Customer becomes the Registered Member of the Café.  

 

5.3.2 To Locate a Customer 
 

The customers registered with the café, can be searched in the café database.  

To locate customers in a Café Database, do the following: 

 

1) On the Customers tab, enter Customer Name. 

2) Click Find In My Café Database. 

      Registered Customer List opens as shown in Figure 5.24. 
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Figure 5.24: Registered Customer List – Find in My Café Database 

 

When the customer is not found in the Café Database, the system gives the choice to search in Online Database as 

shown in Figure 5.25. 

 
Figure 5.25: Find Customer in Online Database 

 

To locate customers in Online Database, do the following: 

1) On Customers tab, enter the Customer Name. 

2) Click Find in Online Database. 

      Search Customer Online list opens as shown in Figure 5.26. 
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Figure 5.26: Search Customer Online 

 

3) If the customer is located in the list, select the customer. 

4) Click Next. 

      The Add/Edit Customer dialog box opens as shown in Figure 5.27. 
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Figure 5.27: Add/Edit Customer 

 

5) Click Finish. 

 

Result: The customer details are found and saved in the local database as shown in Figure 5.28 

 

 
Figure 5.28: Customer is saved in the Café Database 

 

 

Note: Online search is done when CLINCK Cyber Cafe Manager has Internet connection. 

 

5.3.3 To Block a Customer 
 

If the Café host does not want a particular customer to use the terminal, then the customer can be blocked from 

logging on to any client terminal. 

To block a customer, do the following: 
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1) On the Customers tab, select the customer to be blocked. 

 

 

 

Figure 5.29: Customers – Registered Customer List 

 

2) Click Edit Customer. 

 

      Add/Edit Customer dialog box opens as shown in Figure 5.30. 

Customer to be blocked 
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Figure 5.30: Add/Edit Customer 

 

3) Select Block Customer. 

 

Result: The customer is blocked, as shown in Figure 5.31.  
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Figure 5.31: Registered Customer List – Block Customer 

 

5.3.3.1 To Unblock a Customer 
 

To Unblock a Customer, do the following: 

 

1) Select the blocked customer. 

2) Click Edit Customer, as shown in Figure 5.31. 

Add/ Edit Customer dialog box opens. 

Blocked Customer 



Rate Plans and Customers   |   83 

 83 

 

Figure 5.32: Add/Edit Customer– Unblock Customer 

 

3) Clear Block Customer. 

4) Click Finish. 

 

Result: The blocked customer is now unblocked, as shown in Figure 5.33. 
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Figure 5.33: Registered Customer List - Unblocked Customer 

 

 

Note: Customers tab has the following reports: 

� Daily Register Report, see section 11.1.1 

� Customer List Report, see section 11.3.1 

� Customer History Report, see section 11.3.2 

� Member List Report, see section 11.3.5 

� Member History Report, see section 11.3.4  

For more information on these reports, see Chapter 11. 

 

 

Unblocked Customer 

Customer Related Reports 
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6.  

 

 

 

 

 

 

 

 

Chapter 6: Products and Services 
 

Cyber cafés may also sell items or services at their cafe centers. Café owners maintain an inventory of the items 

that they sell. Services include printing, scanning, writing a CD/DVD,  and products include selling CD’s, pen drive, 

cold drinks, coffee and so on, the main objective is to manage all these things using the Cyber Café Manager. 

 

6.1 To View Products and Services  
 

You can view a list of products and services available in the system on the “Products and Services” tab. You can also 

do tasks like Adding or Editing a Product or Service. Figure 6.1, explains this in detail: 
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Figure 6.1: Manage your Product and Services 

6.2 To Add a New Product / Service 
 

6.2.1 To Add a New Service: 
To add a New Product or Service to the customers, the steps are as follows: 

 

1) Click Products & Services tab on the menu bar. 

To Manage Products 
Products and Services Related 

Reports 
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Figure 6.2: Manage your Product and Services 

 

2) Click Add New Product/Service.  

      Add Product/Service dialog box appears.       

 

Figure 6.3: Add Product / Service 

3) Select A Service. 

4) Click Next. 

   The following dialog box appears. 
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Figure 6.4: Add Product / Service 

5) In the Add Product/Service dialog box do the following: 

 Enter Name. 

 Enter Description. 

 Enter Rate/Price you want customer to pay. 

 

Figure 6.5: Add Product / Service 

6) Click Finish. 

      Products & Services window appears. 
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Figure 6.6: Manage your Product and Services 

 

Result: A Service is added in to the list with the Sales Price. 

 

6.2.2 To Add a New Product: 
 

1) Select A Product. 

2) Click Next. 

      Add Product/Service dialog box opens. 
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Figure 6.7: Add Product / Service 

3) In the Add Product/Service dialog box, do the following: 

 Enter Name 

 Enter Description 

 Enter Warning Level 

 Enter Rate/Price you want customer to pay 

 

Figure 6.8: Add Product / Service 

 

 

Note: Warning Level of the product raises an alert when the available quantity reaches the 

minimum level. This indicates that you should buy more of this product, when you get the warning 

level alert. In the above image when the pen drive stock reaches as low as 4, a warning comes up. 

 

4) Click Next. 
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      The following dialog box appears with the Purchase Date entered. 

 

Figure 6.9: Add Product / Service 

5) In Add Product/Service dialog box, enter the following details: 

 Enter the Purchase Date  

 Enter Quantity 

 Enter Cost (Rs.) 

 Enter Total Cost (Rs.) 

 Enter Notes  

 

Figure 6.10: Add Product / Service 

 

6) Click Finish.  

       The following window appears with the product added in the list. 
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Figure 6.11: Manage your Product and Services 

Result: The Product Sale is added.  

 

 

Note: You can add as many products and services. 

 

6.2.3 To Edit a Product / Service: 
 

The Edit button is used to make changes to the Product / Service that is already added.  

 

To Edit a Product/Service, do the following: 

 

1) Select a Product /Service from the list.  

 



Managerial Tasks|   93 

 93 

 

Figure 6.12: Manage your Product and Services 

 

2) Click Edit 

      Edit Product/Service dialog box appears. 

 
Figure 6.13: Edit a Product / Service Sale 

 

3) Enter a new data in the text field which is to be edited in Edit Product/Service dialog box. 
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Figure 6.14: Edit a Product / Service Sale 

 

4) Click Finish. 

      The text field is edited. 
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Figure 6.15: Manage your Product and Services 

 

Result: The product detail is edited.   

 

6.2.4 To Delete a Product / Service: 
     

You can delete a Product or Service using the Delete tab.  

To delete an item, do the following: 

   

1) Select an item that you want to delete from the list. 



96   |   Chapter 7 

             

              

              

               96                  

 

 

Figure 6.16: Manage your Product and Services  

2) Click Delete.  

      The following dialog box opens. 

 

 

Figure 6.17: Product and Services deletion dialog box 

3) Click Yes. 

      The item selected is deleted from the list. 
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Figure 6.18: Manage your Product and Services 

 

Result: The Product / Service is deleted.  

 

Note: The product or service sold to the customer cannot be deleted if the invoice is created for that 

item. 

 

6.3 To Add a Purchase: 
 

Add Purchase is used to enter purchases of a product that you sell in your Cafe. When entering the product, 

provide warning level for the stock too.  

 

 

Note: Add Purchase is active, only when a product in the list is selected. 

 

Adding Purchase:        

 

The steps to Add Purchase are as follows:    

1) Select a Product that you want to purchase. 
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Figure 6.19: Manage your Product and Services 

2) Click Add Purchase. Add Purchase dialog box opens. 

 

Figure 6.20: Add Purchase 
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3) In the Add Purchase dialog box, do the following: 

 Enter the Purchase Date 

 Enter the Quantity 

 Enter the Cost (Rs.) 

 Total Cost(Rs.) updates automatically 

 Enter Notes 

 

Figure 6.21: Details of the Purchase 

4) Click Save. 

 

Result:  Purchase is added to the product, and the Total Cost (Rs.) is generated in the Purchase Report as shown in 

Figure 6.22. 
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Figure 6.22: Manage your Products and Services   

 

 

Note: Products & Services tab has the following reports: 

� Product List Report, see section 11.5.1 

� Purchase Report, see section 11.2.4 

� Product and Service Consumption Report, see section 11.5.2 

For more information on reports, see Chapter 11. 
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Figure 6.23: Purchase Report 

 

6.4 To Sell an Item to the Customer  
 

You can largely sell products in two ways: 

  Sell a product to the customer who sits for an Internet connection 

  Sell a product to a Walk- in Customer 

 

6.4.1 Customer Accessing the Internet 
 

1) Locate the terminal on which the customer is sitting, in the Terminal list window. 
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Figure 6.24: Manage Terminals 

2) Right click on the terminal and select Add a Product / Service Sale. 

 

 

Figure 6.25: Manage Terminals 

 

Add a Product /Service Sale window opens with the Customer Name, Address, Bill/Invoice No., and Date 

generated automatically.  
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Figure 6.26: Add a Product / Service Sale 

 

3) In the Add a Product/Service Sale dialog box, do the following: 

 Select Item from the dropdown list 

 Enter Quantity  

         The Selling Price is generated automatically. 

4) Click Add Item. 

      The Item Name with the Quantity and Total Price (Rs.) is added.  

      The Total (Rs.) is generated automatically, based on the added item. 

5) Click Add to Bill. 

 

Result: The Product / Service is sold to the customer. 

 

6.4.2 Walk-in Customer 
 

1) Click Home > Add a Product / Service Sale. 
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Figure 6.27: Home - Add a Product / Service Sale 

   The Add a Product/Service Sale dialog box appears. 

 

Figure 6.28: Add a Product / Service Sale 

2) To Add a Product/Service Sale, do the following: 

 Enter Customer Name 

 Enter Address 

 Bill/Invoice No. and Date gets generated automatically 

 Select Item from the dropdown list 

 Enter Quantity  

          The Selling Price is generated automatically          

 

3) Click Add Item. 
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      The Item Name with the Quantity and Total Price (Rs.) is added.  

 Enter Discount amount.  

 Enter Discount Description, if any discount is available 

            The Total (Rs.) is generated automatically, based on the added item. 

 Enter the Amount Received (Rs.) from the Customer, 

             And the amount to Return to Customer (Rs.) is automatically generated. 

 

Figure 6.29: Add a Product / Service Sale 

4) Click Pay.    

 

Result: Either Product / Service is sold to the customer. 

 

6.5 To Remove an Item 
 

To remove an item, do the following: 

 

1) Select an Item from the Add a Product / Service Sale dialog box. 
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Figure 6.30: Add a Product / Service Sale 

2) Click Remove Item. 

      The following dialog box appears. 

 

Figure 6.31: To remove the selected record 

3) Click Yes. 

 

Figure 6.32: Add a Product / Service Sale 

 

Result: The selected item is removed from Product/Service Sale list. 

 



Managerial Tasks|   107 

 107

 

 

 

7.  

 

 

 

 

 

Chapter 7: Managerial Tasks 
 

This chapter describes all the tasks that a café owner/manager may have to perform to manage the café using 

CLINCK Cyber Café Manager. 

 

CLINCK Cyber Café Manager provides the manager/admin with certain rights. These rights allow him to have better 

control than the employees of the café center.  

The Managerial Tasks the manager/admin does are: 

 To Re-login customer sessions 

 To change the Printer Settings 

 To set Schedule Backups 

 To generate Temporary Password 

 To change the Rate Plans 

 To add/edit Customers 

 To sell Membership Packages 

 To add/edit new users 

 To add/edit and sell Product and Services 

 To shutdown/restart Terminals 

 To close/transfer Customer Session 

 To delete a Terminal 

 To Carry Forward remaining minutes 

 Backup and Restore 

 Application Settings 

 View all the Reports 

 To close Café Management Client 

 

Few of these tasks are discussed here in this chapter.  

 

7.1 Admin Login on Client Side   
 

Admin Login on the Client side is only for the employee with admin rights, so that he can login to the CLINCK Cyber 

Café Client, and then restart/logoff/shutdown the terminal, when the CLINCK Cyber Café Client is not able to 

connect to the CLINCK Cyber Café Server. 

 

Two instances while closing the CLINCK Cyber Café Client are: 

 When the Client machine is connected to CLINCK Cyber Café Manager Server. 

 When the Client machine is not able to connect to CLINCK Cyber Café Manager Server.  
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When the Client machine is connected to CLINCK Cyber Café Manager Server, do the following: 

 

1) Click the Admin Login. 

 

 

 

Figure 7.1: Admin Login when Local Server is available  

Employee Login dialog box opens. 

 

Figure 7.2: Employee Login  
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2) In the Employee Login dialog box, do the following: 

 Enter Employee Name  

 Enter Password 

3) Click Login 

The CLINCK Cyber Café Manager: Settings dialog box opens. 

     

 
Figure 7.3: CLINCK Cyber Café Manager: Settings 

4) Click Exit Café Manager Client. 

The Café Manager Client application is closed. 

 

When the Client application is not able to connect to CLINCK Cyber Café Manager Server, do the following:  

1) Click Admin Login.  
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Figure 7.4: Admin Login when Local Server is not available  

 

Online Verification window opens. 
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Figure 7.5: Online Verification 

 

 

 

Online Verification window has two methods:  

 If Internet is connected, the user must enter Cafe Code and Partner Site Password for Online Verification.  

 If Internet is not connected, you must generate temporary password.  

 

Two ways to generate temporary password: 

 From CLINCK Cyber Café Manager Server  

 From Ideacts Partners Site 

 

 To Generate Temporary Password from CLINCK Cyber Café Manager Server: 

 

a. On the Help menu, click Generate Temporary Password. 

Online Verification 

Generate Temporary 

Password 
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Figure 7.6: Help - Generate Temporary Password 

 

                    Generate Temporary Password dialog box opens, as shown in Figure 7.7. 

b. In the Generate Temporary Password dialog box, do the following: 

 Enter Unique ID, got from the Online Verification window on the client machine. 

 

 

Note:  

� See Figure 7.5 for Unique ID. 

� Café Code need not be entered, as it is based on the particular cafe. 

 

c. Click Generate Temporary Password. 

 

 
Figure 7.7: Generate Temporary Password 

 

Temporary Password gets generated automatically. 

 

 To Generate Temporary Password from Ideacts Partner Site: 

 

a. In the Ideacts partner site, http://www.ideacts.com/cms/partner/Login.aspx : 

 Enter the Café Code and Password.  

 Click Sign in. 

Partner Landing page opens. 
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Figure 7.8: Partner Landing 

 

b. In the Partner Landing page, click Generate Temporary Password.  

Generate Temporary Password window opens as shown in Figure 7.9. 

c. In the Generate Temporary Password window, do the following: 

 

 

Note: See Figure 7.5 for Unique ID. 

 

 Enter the Unique ID, got from the Client terminal.  

 

d. Click Generate Temporary Password. 
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Figure 7.9: Generate Temporary Password 

    Temporary Password gets generated automatically. 

2) Enter the Temporary password in Figure 7.5. 

 

Note: This password can only be reused until the application is running. If the application stops and 

restarts a new Unique ID and password is required. 

3) Click Login. 

 

Result: The login to the terminal is successful. 

 

7.2 To Switch an Employee 
 

 

Note: Switching an employee is important, when more than one person manages a Café. Largely 

because the sales and collections are tracked separately for each employee. 

 

Suppose an employee works for first half of the day, and another employee works for the second half and the first 

person finishes his work for the day, and returns his work to the second person. Then, the second person must login 

with his name and password, and manage the work for the remaining part of the day. This is done by switching 

between employees. 

 

Before switching between employees, the actual screen is as shown in Figure 7.10. 
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Figure 7.10: CLINCK Cyber Café Manager with the admin logged in 

To switch between employees, do the following: 

 

1) On the File menu, click Switch Employee. 

 

Figure 7.11: File – Switch Employee 

Server Login dialog box opens as shown in Figure 7.12. 

Employee logged-in is 

“Admin” 
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2) In the Server Login dialog box, do the following: 

 Enter Employee Name  

 Enter Password 

 Click Login 

 

Figure 7.12: Server Login  

The Employee is now logged-in to the Server. 

Result: Switching between employees is done successfully. 

 

7.3 To Set Session Time 
 

Set Session Time option is used to set time for customer’s session. By setting a session time, the customer is logged 

off, when the time expires after two warnings. The customer can also see the Time Remaining in the Session 

window. 

The steps to set session time are as follows: 

1) On the Home tab, right click on the terminal where the customer is currently logged in.  

2) Click Set Session Time.  

 

Figure 7.13: Manage Terminals 

Set Session Time dialog box opens.  
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Figure 7.14: Set Session Time 

3) In Set Session Time dialog box, do the following: 

 Enter Total Session Time 

 Enter Time Remaining  

 Enter Set Session Time 

4) Click Save. 

Towards the end of the session, when 60 seconds is remaining, a Session dialog box pops up reminding the 

customer about session end time. 

 

Figure 7.15: Session 

 

Note: This session time can be extended any time during the session. 

 

Result: The Session Time is set. 

 

7.4 To Renew a Session 
 

Renew session time option is used to renew time for a customer’s session. This will add on the new time duration 

to the existing one. 

 

The steps to renew a session time are as follows: 

 

1) On the Home tab, right click on the terminal where the Session time is already set. 

Select Renew Session Time. 
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Figure 7.16: Manage Terminals – Renew session time 

Renew Session Time dialog box opens. 

 

Figure 7.17: Renew Session Time 

2) Enter Renew Session Time. 

3) Click Renew. 

Result: The Session time is renewed. 

 

7.5 To Transfer a Session 
 

A customer may sometimes ask for a transfer of session, when he/she is uncomfortable with the place or realizes 

that the webcam/headphone/microphone is not available on the terminal. If a customer wants to change his/her 

terminal you can transfer the session to another client terminal. 

 

The steps to transfer a session are as follows: 
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1) On the Home tab, right click on the terminal where the customer is currently logged in.   

 

Figure 7.18: Manage Terminals – Transfer Session 

2) Select Transfer Session. 

      Transfer Session dialog box appears.   

 

Figure 7.19: Transfer Session 

3) Select the available idle terminal from the Terminal drop down. 

 

 

 

Note: This figure indicates an Idle terminal. 

4) Click Switch. 

      The customer session is transferred from TERMINAL 1 to TERMINAL 2. 
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Figure 7.20: Manage Terminals 

 

Result: The Session is transferred. 

 

7.6 To Close a Session 
 

When a customer logs out, you must close the session before giving the system for use to another customer.  

To close a session, do the following: 

 

1) Right click the Terminal on the Home tab.  

2) Select Close Session. 

 

Figure 7.21: Manage Terminals – Close Session 

 

Close Customer Session dialog box opens with the Customer Name, Bill/Invoice No., Terminal, Date and the 
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Total (Rs.) the customer has to pay. 

 

Figure 7.22: Close Customer Session  

 

Note: You can sell items to a customer while closing the session. 

3) Click Pay. 

 

Result: The customer session is closed. 

 

7.7 To Renew Membership Package 
 

When a customer asks to extend his/her membership, you can renew the existing membership package of the 

customer.     

 

Membership Package can be renewed in two ways: 

 

 Right-click on the terminal of the Home tab, where the customer is logged in, and then renew the 

membership package. 

 To locate a customer and then renew the membership package. 

To renew the membership package, do the following: 

 

1) Right click on the terminal where the customer is logged in and select Renew Membership. 
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Figure 7.23: Selected Terminal - Renew Membership 

2) To locate a customer and then renew the membership package, do the following: 

1. Find a Customer from Customers tab. 

2. Enter Login ID. 

3. Click Find in My Café Database. 

               The customer is found, if his database exists. 
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Figure 7.24: Customer List 

3) Click Renew Membership. 

     Renew Membership dialog box opens with the Details of existing membership package. 

4) Select the available Membership Package.   
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Figure 7.25: Renew Membership Package 

 

Figure 7.26: Renew Membership Package 
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5) Select Carry forward existing minutes. 

      The Minutes to carry forward is calculated automatically.  

 

 

Note:  

� Carry forward existing minutes can be used when a member is unable to use the remaining 

minutes of the package within its validity period. These remaining minutes can be carried forward 

to the new package.  

� For a customer who becomes a member for the first time, Carry forward existing minutes is not 

selected. 

� When the Expires in (Days) is Expired, then Carry forward existing minutes and Minutes to carry 

forward cannot be edited. 

 

 

Figure 7.27: Renew Membership Package 

6) Click Pay. 

The membership is renewed with the existing package. 

      

Result: The Membership Package is renewed. 

 

7.8 To View the Membership Package Details 
 

To view the membership package details, do the following: 

     

1) Select the customer from the Registered Customer List. 
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Figure 7.28: Customer List 

2) Select the View Membership Details of the selected customer. 

      View Package dialog box opens. 

 

Figure 7.29: View Package 
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The membership is renewed along with the previously existing package. 

The Minutes Left in the membership package is renewed from 175 (in Figure 7.25) to 275 (in Figure 7.29). 

Result: The membership is renewed and viewed. 

7.9 To Change the Application Settings 
To manage General, Auto Server Mode, Rate Plan, and URL Tracking settings, do the following: 

1) On the File Menu, click Application Settings. 

 
Figure 7.30: File – Application Settings 

The Application Settings dialog box opens with the following tabs: 

 General 

 Auto Server Mode 

 Rate Plans 

 URL Tracking 

Each of these tabs is explained below. 

 

Figure 7.31: Application Settings 
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 General tab 

The General tab allows you to manage general settings for the CLINCK Cyber Café Manager. You can view and 

edit your cyber café name and address, choose whether to close all applications on a terminal at the time of 

logout, and enable a network log.  

 In the Application Settings dialog box, click the General tab. 

 

Note:  

� See Figure 7.32 for General tab. 

� All fields marked (*) in the General tab are mandatory. Cyber Café Name and Cyber Café Address 

are mandatory fields and should not be left blank. 

• Type or edit the Cyber Café Name. 

• Type or edit the Cyber Café Address. 

• Select Close Application on Customer logout. 

With this feature, all the applications opened by the customer get closed, when the session is closed from 

the CLINCK server.  

• Select the Enable Network Log, to enable the network log. 

 

Note:  

� The network log should be enabled to track network communication between the CLINCK client 

and server. 

� It helps as a debugging tool and is mostly used by Ideacts engineers. You can enable the network 

log to record information if you are getting an error. This information may be useful when an 

engineer visits your cyber café to correct the problem. 

� By default, the path for the network log is <Application Path>\Log\ 

 
Figure 7.32: Application Settings – General 

 Auto Server Mode tab 
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The Auto Server Mode lets you run the CLINCK Cyber Café Server independently. In other words, in the auto 

server mode, the CLINCK server does not need to be operated by a person. This feature allows a customer to 

directly login from a terminal (client machine) as a walk-in customer without registration. In this mode, the 

server also automatically closes the terminal’s session when the client logs out. 

 

In the Auto Server Mode tab, you can change the settings for CLINCK’s auto server mode. 

 In the Application Settings dialog box, click Auto Server Mode. 

 

Note: See Figure 7.33 for Auto Server Mode. 

• Select Allow customer to directly login as a Walk-in from the client machine.       

      With this feature, the customer is allowed to login directly from the client machine. 

• Select Automatically perform close session when a customer logout. 

With this feature, the CLINCK server automatically closes the session on a terminal, when customer logs 

out.     

 

Note:  

� When this feature is selected, the session will automatically close, and after that it will not be 

possible to change the customer’s bill or use the Re-login feature. 

� When you select this feature, the Show alert on customer logout check box becomes enabled. 

• Select Show alert on customer logout. 

With this feature, an alert is displayed on the CLINCK server when a customer logs out. 

 

 

Note:  

� In the Auto Server Mode tab, the customer’s name moves from the Active Customer Sessions 

panel to the Closed Customer Sessions panel, where the logout time, duration and charges of 

internet usage, charges for any other products or services purchased, and the total amount to be 

paid by the customer are displayed. At the same time, the Home tab changes the color and blinks 

to indicate that some changes have taken place there. 

� In the Home tab, the customer’s name disappears from the terminal in the Terminals Pane and 

details of the logout are added to the Closed Sessions tab of the Updates Pane. 

� Also if you have minimized the server window the tab in the task bar blinks. The Home tab in the 

application also blinks if you are on any other tab. 

 



130   |   Chapter 7 

             

              

              

               130                  

 

 
Figure 7.33: Application Settings - Auto Server Mode  

 

 

Note: When the CLINCK server is in auto server mode, this status of the server is displayed on the top 

of the server screen as shown in Figure 7.34. 
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Figure 7.34: CLINCK Cyber Café Manager – Auto Server Mode 

 Rate Plans tab 

      In pulse-based membership, a fixed number of minutes are deducted from the member’s package.  

 

     Using the Rate Plans tab, you can enable pulse-based membership for your cyber café and manage its settings. 

 In the Application Settings dialog box, click the Rate Plans tab. 

 

Note:  

� See Figure 7.35 for Rate Plans.  

� All fields marked (*) in the Rate Plans tab are mandatory. 

• Select Enable Pulse Based Membership. 

With this feature, pulse-based membership is enabled. 

 

Note:  

� When pulse-based membership is enabled, sessions for members will have to be closed in the same 

manner as closing sessions for registered customers. 

� When you select this feature, the Pulse Time field and the Display pulse deductions on client 

terminals check box are enabled. 

• Enter the Pulse Time, you want to set. 

 

Note:  

� If pulse-based membership is enabled, this field is mandatory and should not be left blank. 

� When you select this feature, the number of minutes specified as pulse time will be deducted from 

the customer’s membership package. 

• Select Display pulse deductions on client terminals. 

With this feature, certain minutes that are deducted from the customer’s membership package are 

displayed on the client terminal. 
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Note: When this feature is selected, information regarding pulse deductions will be displayed on the 

Session Details and Session Logout screens of the client terminal. 

 

 
Figure 7.35: Rate Plans tab 

 URL Tracking tab 

The URL Tracking feature of the CLINCK Cyber Café Manager is used to keep a record of the websites visited by 

customers.  

When URL tracking is enabled on the CLINCK server, the customer’s browsing history is stored at a chosen location 

on your computer as a text file (CSV format). The file stores the customer ID, customer name, terminal name, URL 

of visited website, and the date and time when the website was visited. 

 

 

Note: The URL tracking data is not uploaded to Ideacts. It is stored only in your cyber café. 

Using the URL Tracking tab, you can enable URL tracking for your cyber café and manage its settings. 

 In the Application Settings dialog box, click the URL Tracking tab. 

 

 

Note:  

� See Figure 7.36 for URL Tracking. 

� All fields marked (*) in the URL Tracking tab are mandatory. Folder Path and Keep only last are 

mandatory fields and should not be left blank. 
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• Select Enable URL Tracking. 

With this feature, URL tracking is enabled in your cyber café. 

 

Note: Click terms & conditions next to the Enable URL Tracking check box, to read the additional 

terms and conditions for enabling URL tracking. 

• Click Browse and choose a folder path, where you want to create the text file that stores URL tracking 

data. 

 

Note: Click Open this folder to view the contents of the folder specified in the Folder Path box. 

• Enter Keep only last. 

With this feature, the URL tracking data is kept for a minimum of 60 days. 

 

 

Figure 7.36: URL Tracking tab 

2) After you have made the necessary changes in one or more tabs of the Application Settings dialog box, click OK 

to save your changes, or click Cancel to close the dialog box without saving the changes. 

On the URL Tracking tab,  

 Click Cancel. 

              The Application Settings confirmation dialog box appears. 

 
Figure 7.37: Application Settings confirmation dialog box 
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 Click Yes. 

       With this option, the application settings entry gets cancelled and the dialog box closes without saving the  

changes that you made. 

 Or  

 Click No, to go back to the Application Settings dialog box. 

 

7.10 To Lock and Unlock Server 
 

The Lock Server feature in the File menu locks the CLINCK server and disables all its options. In the locked state, it is 

not possible to perform any tasks on the server.  

 

To lock the Server, do the following: 

1) On the File menu, click Lock Server.  

 

Figure 7.38: File – Lock Server 

 

  The CLINCK server becomes locked, with all options on the screen disabled and unavailable, as shown in Figure 7.39. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the locked state, all the tabs are 

disabled  
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Figure 7.39: CLINCK Cyber Café Manager – Auto Server Mode - (Locked) 

 

Note: You can select a terminal to view the terminal information even when the server is locked. 

 

Result: The Server is locked. 

 

Whereas, Unlock Server unlocks the server after it has been locked using Lock Server. 

To unlock the Server, do the following: 

1) On the File menu, click Unlock Server.  

 
Figure 7.40: File – Unlock Server 

 

The Server Login dialog box appears. 
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Figure 7.41: Server Login  

2) Enter Employee Name. 

3) Enter Password. 

4) Click Login. 

Now, the locked server is unlocked. 

 

Note: Click Cancel to maintain the server in the locked state. 

 

Result: The locked server is unlocked. 

7.11 To Shutdown All Terminals 
 

This option allows you to shutdown all terminals which are connected to the server using a single command. 

To shutdown all terminals, do the following: 

 

1) On the Home page, under the System Tools, click Shutdown All Terminals.  

 

 
Figure 7.42: Home – Shutdown All Terminals 

View Terminal dialog box appears. 
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Figure 7.43: Shutdown All Terminals  

2) Click Yes. 

All the terminals are shutdown at the same time. 

 

Note: Click No to cancel the task. 

 

Result: All the terminals are shutdown at the same time. 

 

7.12 To Restart All Terminals 
 

This option allows you to restart all terminals which are connected to the server using a single command. 

To restart all the terminals, do the following: 

 

1) On the Home page, under the System Tools, click Restart All Terminals.  

 

 
Figure 7.44: Home – Restart All Terminals  

View Terminal dialog box appears. 
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Figure 7.45: Restart All Terminals  

2) Click Yes 

All the terminals are restarted at the same time. 

 

Note: Click No to cancel the task. 

Result: All the terminals are restarted at the same time. 

7.13 To Re-connect All Terminals 
This option is used if you do not see some of the connected terminals on your Home page. 

To reconnect all the terminals, do the following: 

1) On the Home page, under the System Tools, click Re-connect All Terminals.  

 
Figure 7.46: Home – Re-connect All Terminals  

Manage Terminals dialog box appears. 

 
Figure 7.47: Re-connect All Terminals 

2) Click Yes  

All the terminals are re-connected together at the same time. 

 

Note: Click No to cancel the task. 

 

Result: All the terminals are re-connected at the same time. 
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7.14 Managerial Reports 
 

To manage the café, the café manger maintains the following reports: 

 Terminal Usage Report 

 Server Up Time Report 

 Close Café Client Report 

On the Reports tab, towards the left corner is the Café Management Reports. 

This is as shown in the Figure 7.48. 

 

 
Figure 7.48: Café Management Reports 

 Terminal Usage Report: 

The Terminal Usage Report gives information about which terminal is being used how many time by 

customers. The Terminal Usage Report screen for the current date is as shown in Figure 7.49. 

 
Figure 7.49: Terminal Usage Report 

 

Note: For more information on Terminal Usage Report, see section 11.4.1. 

 Server Up Time Report: 

The Server Uptime Report gives detailed information about the start and close of CLINCK server. The Server 

Up Time Report for the current date is as shown in Figure 7.50. 
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Figure 7.50: Server Up Time Report 

 

Note: For more information on Server Up Time Report, see section 11.4.2. 

 Close Café Client Report: 

The Close Cafe Client Report gives information about how many times a terminal’s client application was 

closed by an employee. The Close Café Client Report screen is as shown in Figure 7.51. 

 
Figure 7.51: Close Cafe Client Report 

 

Note: For more information on Close Cafe Client Report, see section 11.4.3. 
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8.  

 

 

 

 

 

 

Chapter 8: URL Tracking 
 

URL Tracking is a feature which records and saves the website URL visited by a customer from a client terminal. The 

data is saved locally on the CLINCK Cyber Café Manager Server in your cafe.  

 

The URL tracking feature is very useful to the café owner as you keep a check on which website your customers are 

visiting. This data is also critical to law and order enforcement authorities, to monitor and prevent illegal activities. 

 

 

Note: URL Tracking is an optional feature and is disabled by default. 

 

 

8.1 To Enable URL Tracking 
 

To enable the URL Tracking feature, do the following: 

 

1) On the File menu, click Application Settings. 

 
Figure 8.1: File – Application Settings 

 

Application Settings dialog box opens. 
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Figure 8.2: Application Settings – URL Tracking 

2) In the Application Settings dialog box, click the URL Tracking tab. 

3) In the URL Tracking dialog box, do the following: 

 Select Enable URL Tracking. 

 Click Browse and choose a folder path, to store the data of tracked URLs. 

 By default, the tracked data is saved in the folder path for 60 days. After completion of 60 days, the oldest 

files get deleted first, with the remaining files. 

4) Click OK. 

 

Note: URL Tracking is not supported by Windows 2000 Professional operating system. 

 

Result: URL Tracking is enabled. 

 

8.2 To View the Browsing History 
 

The data of each of the tracked URLs is stored in the Comma-separated-value format (CSV format), in the Folder 

Path chosen by you. 
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Note:  

� The data based on the tracked URLs, is not loaded on Ideacts server. Rather, the data is available 

only in your café, at the specified path. 

� To save the “Text File” in CSV format, select a drive which has sufficient space. 

� The default path to save data is the URL Tracking folder, where CLINCK Cyber Café Manager is 

installed. 

� At least, one CSV file is created for each day.  

� CSV format is a text file format. 

To view the browsing history, do the following:  

 

1) On the URL Tracking tab, Click Open this folder.  

 

 
Figure 8.3: URL Tracking – Open this folder 

The folder opens as shown in Figure 8.4.  

 

 
Figure 8.4: Browsing History storage folder 

 

2) Double-click a given file from this folder.  

The CSV file opens in Excel format, as shown in Figure 8.5. 

 

 

Note: CSV files can be opened using Notepad and Excel. 
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Figure 8.5: CSV File 

 

3) The CSV file contains the following fields:  

 Customer ID: Login ID for Registered Customers. Else WALKIN, for a Walk-In Customer. 

 Customer Name: Name of the Customer. 

 Terminal Name: The Computer Name, which the customer used for browsing. 

 URLId: Used for internal purpose only. 

 URL: The browsed URL. 

 Date time: Used to check the date and time, the URL is browsed. 

 

Result: The browsing history is viewed. 
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9.  

 

 

 

 

 

Chapter 9: Print Manager 
 

Print Manager helps you in monitoring printouts sent to different printers, within the Café. These printouts can be 

optionally added to the logged-in customer’s bill. 

 

 

Note: With Print Manager, multiple printers can also be monitored. 

 

9.1 To Configure the Print Manager 
 

For the Print Manager to work, you need to enable Print Manager on the printers to be monitored. 

 

When printer is not configured on the server, the Print Manager tab, guides you in configuring the printer, as 

shown in Figure 9.1. 

 

Figure 9.1: Printer Manager is not configured 

To configure Print Manager, do the following: 

 

1) On the Print Manager tab, click Change Settings. 
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The Print Manager Settings dialog box opens, listing the printers installed.  

 
Figure 9.2:  Print Manager Settings 

2) Select the printer that you wish to monitor. 

3) Select Enable print manager on this printer, as shown in Figure 9.2. 

      When this feature is checked, all the printouts taken from this printer is monitored. 

4) Select Automatically add prints to the customer’s bill, as shown in Figure 9.3.  

      With this feature, printouts are added automatically to the customer’s bill. 

 

Figure 9.3:  Print Manager Settings 
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5) Select a Service for the selected printer. 

 

When the selected printer is in use, the selected service is automatically added to the customer’s bill. 

 

 

Note:  

� See Figure 9.3 to select a service or define new service. 

� If no service is defined, then from the Select a Service dropdown, select Add New Service. (Refer to 

Figure 9.3) 

 
� Select A Service 

 
 

� Enter Name, Description and Rate/Price you want customer to pay. 
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6) Click Save. 

Manage Print Jobs window opens as shown in Figure 9.4. 

 

Result: Print Manager is configured on the system. 

 

9.2 Print Manager Window 

 

� Click Finish.  

   Now the added service comes in the Select a Service dropdown. 

 

 
 



Print Manager   |    149 

 149

 

When the Print Manager is enabled the Print Manager Tab will start showing the following: 

 

a. Active Print Jobs 

b. Completed Print Jobs 

c. Common Tasks/ Related Reports 

 

 

 

 

 

 

 

Figure 9.4:  Manage Print Jobs 

 

a. Active Print Jobs: Lists the jobs currently being printed.  

 

The following details are listed in an Active Print Job: 

• Printer Name: Name of the printer in use. 

• Terminal Name: Name of the Client terminal. 

• Customer Name: Name of the Customer requesting for print. 

• Document Name: Name of the document to be printed. 

• Total Pages: Total number of pages sent for print. 

• Status: Whether the service is In-progress/completed. 

 

b. Completed Print Jobs: Lists all the printouts that are completed. 

Print Manager 

Related Reports 

Active Print 

Jobs 
Completed Print Jobs 
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Completed Print Job lists all the details of Active Print Job, with an additional detail, Amount (Rs.). 

• Amount (Rs.): The total amount the customer must pay the café for printouts.  

 

 

Note: If print is done from a terminal that does not have CLINCK Cyber Café Client (or the terminal 

with CLINCK Cyber Café Client closed) or Server, the Customer Name displayed is “Unknown”. 

c. Common Tasks/ Related Reports: 

 

 

Note:  

� For information on Print Manager Change Settings, see section 9.1. 

� For Printer Usage Report, see section 11.6.1. 

� For Printer Summary Report, see section 11.6.2. 
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10.  

 

 

 

 

 

 

Chapter 10: Auto Server Mode 
 

Auto Server Mode helps the Walk-In Customer to directly login and logout from the Clinck Cyber Café Client 

terminal, with no manual work to be done on the Clinck Cyber Café Manager Server as to, Registering Customers or 

Closing Customer Sessions. 

 

 

Note: Auto Server Mode is an optional feature. 

 

10.1 To Enable the Auto Server Mode 
 

To enable Auto Server Mode, do the following: 

 

1) On the File menu, select Application Settings. 

 

Figure 10.1: File – Application Settings 

Application Settings dialog box opens as shown in Figure 10.3. 

 

2) In the Auto Server Mode settings dialog box, do the following: 

3)  
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Note: See Figure 10.3 for Auto Server Mode. 

 Select Allow customer to directly login as Walk-In from the client machine. 

 

             With this feature, Walk-In customers can directly login to the client terminal. 

 

 

Figure 10.2: Login for a Walk-In Customer 

 

 Select automatically perform close session when a customer logout. 

 

             With this feature, the customer session gets closed automatically, on log out. 

 

 

Note: Once the session is closed, neither the customer can Re-login, nor can the bill be changed. 

 

 

Figure 10.3: Application Settings – Auto Server Mode 

 Select Show alert on customer logout. 
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            This feature alerts the CLINCK Cyber Café Manager, when the customer logs out. 

 

4) Click OK. 

 

Result: Auto Server Mode is enabled on the terminal, as shown in Figure 10.4. 

 

10.2 To Manage Sessions in Auto Server Mode  
 

When the Auto Server Mode is enabled you can manage all customer session using the Auto Server Tab 

Auto Server Mode tab provides two lists: 

 

1. Active Customer Sessions. 

2. Closed Customer Sessions. 
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Figure 10.4: Auto Server Mode 

1. Active Customer Sessions: 

 

 

Note: See Figure 10.4 for Active Customer Sessions. 

 

Active Customer Sessions lists the Customers logged-in currently.  

a. The Active Customer Sessions list has the following fields: 

 

 Customer Name: Name of the customer. 

Logged out 

Customers 

Active Customer 

To Enable/Disable Auto Server Mode 

Auto Server 

Mode is enabled 
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 Customer Type: Walk-In Customer / Registered Customer/ Registered Member. 

 Terminal Name: Client Terminal Name. 

 Time In: The time the customer logged-in. 

 Internet Usage (Rs.): Based on the Rate Plan set, the internet usage amount is        displayed. 

 Products/Services (Rs.): When the Café sells a Product/Service to the customer, the amount is 

displayed here. 

 Total (Rs.): Total amount the customer must pay the Cafe. 

 

b. When you want to view the customer details, Click View Customer Details. 

         View details of your Customer dialog box opens. 

 

Figure 10.5: View full Customer Details 

c. When you want to view the bill/invoice details, Click View Bill/Invoice Details. 

             The billing detail for a particular customer is as shown in Figure 10.6.  
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Figure 10.6: View Bill/Invoice Details 

d. When you want to close an active customer session, Click Customer Logout. 

       The Auto Server Mode dialog box appears.  

 

 
Figure 10.7: Auto Server Mode – Close Customer Session 

 

Note: Close Customer Session is done automatically, as shown in Figure 10.3, by selecting 

“Automatically perform close session when a customer logout” in Application Settings. 

2. Closed Customer Sessions: 

 

 

 

 

Note: See Figure 10.4 for Closed Customer Sessions. 

Closed Customer Sessions, lists the customers logged out for that particular day.  

 

a.  The two additional fields in Closed Customer Sessions are:  

 Time Out: Log out time of a customer. 

 Duration (HH:MM): The overall time, the customer used the terminal. 

b. When you want to view the bill/invoice details, Click View Bill/Invoice Details. 

 

The billing details for a particular customer are as shown in Figure 10.6.  

 

Note: Customer details cannot be viewed for a Walk-In Customer. 
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11.  

 

 

 

 

 

 

Chapter 11: Reports  
 

There are many types of reports that you can generate on the CLINCK Cyber Café Manager’s server to quickly view 

and understand useful information. All these reports are listed in the left panel of the Reports tab in the CLINCK 

server window. Some of these reports are also provided under the other tabs as needed. 

 

 
Figure 11.1: Reports tab 
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The CLINCK server’s reports are classified into six categories: 

 

 General Reports – This category has the following general purpose report: 

 Daily Register Report 

 

 Financial Reports – This category has the following reports showing the cyber café’s financial details: 

 Collection Report 

 Summary Collection Report 

 Monthly Collection Report 

 Purchase Report 

 Invoice List Report 

 Invoice Detail Report 

 Adjustment Report 

 

  Customer Reports – This category has the following reports related to the cyber café’s customers: 

 Customer List Report 

 Customer History Report 

 Customer Details Report 

 Member History Report 

 Member List Reports 

 

 Café Management Reports – This category has the following reports related to managing the cyber café: 

 Terminal Usage Report 

 Server Up Time Report 

 Close Café Client Report 

 

 

 Product & Service Reports – This category has the following reports related to the products and services 

provided by the cyber café: 

 

 Product List Report 

 Product and Service Consumption Report 

 

 Printer Reports – This category has the following reports related to the printers used in the cyber café: 

 Printer Usage Report 

 Printer Summary Report 

 

 

Before discussing each report in detail, let us understand a typical report screen. 

 

On any report screen, you will always find the following two elements: 

 

 Report Filter: It is a filter section where you can give one or more conditions for the report. It helps in getting 

customized or selected reports to suit your need. For example, you can specify the name of an employee in the 

Employee field of the report filter to generate a report for one particular user. 
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Figure 11.2: Example of a Report Filter 

 

 Report Toolbar: It is a toolbar with many features that can be used for a report. It appears above the report. 

 

Report Filter 

Formatted: Bullets and Numbering
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Figure 11.3: Report Toolbar 

 

The icons on the report toolbar are explained in Table 11.1. 

 

 

 

 

 

 
 

 

Figure 11.4: Report Toolbar Icons 

 

 

Note: One or more of these buttons might be disabled depending on the report. 

 

Report Toolbar 

1 7 

8 10 

11 

12 14 

15 

2 

3 

4 

5 

6 

9 13 

16 
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No. Icon Icon Name Function 

1 
 

Show or Hide Document Map 
Click to display or hide the document map 

for the report. 

2 
 

First Page Click to go to the first page of the report. 

3 
 

Previous Page 
Click to go to the previous page of the 

report. 

4 
 

Current Page of Total Pages 

In the Current Page box, type the page 

number to go to directly, and then press 

Enter. The Total Pages field displays the 

total number of pages in the report. 

5 
 

Next Page Click to go to the next page of the report. 

6 
 

Last Page Click to go to the last page of the report. 

7 
 

Back to Parent Report 
Click to go back to the parent report of the 

current report. 

8 
 

Stop Rendering Click to stop the report generation process. 

9 
 

Refresh Click to refresh or create the report again. 

10 
 

Print 
Click to print the report on a printer 

connected to the CLINCK server. 

11 
 

Print Layout 
Click to see a preview of how the report will 

look when printed. 

12 
 

Page Setup 
Click to view and change the page setup of 

the report for a printout. 

13 
 

Export 

Click the arrow next to the Export box to 

save the report in a Microsoft Excel sheet or 

as an Acrobat (PDF) file. 

14 
 

Zoom 

Click the arrow next to the Zoom box and 

select a value to view the report in a 

different size.  

15 
 

Search Text and Find 

In the Search Text box, type the search text 

that you want to find in the report, and 

then click Find.  

16 
 

Find Next 
Click to find the next place where the 

search text appears in the report. 

Table 11.1: Report Toolbar Icons 
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Each report available in the Reports tab is explained in the remaining chapter. 

 

 

Note:  

� You should be logged in to the CLINCK server to view the reports. 

� Mandatory fields for generating reports are marked with    in the figures. 

11.1 General Reports 
 

11.1.1 Daily Register Report 
 

The Daily Register Report gives the details of all the customers who visited your cyber cafe on the date that you 

provide in the report filter. The report includes all types of customers, that is, walk-in customers, registered 

customers, and registered members. The following information is displayed in the report: 

 

 Customer Name – Name of the customer who logged into a terminal of the café on that date  

 Address – Customer’s address 

 Contact Number – Customer’s telephone number 

 ID Card Type – Type of ID card provided by the customer 

 ID Card No. – ID card number 

 Terminal Name – Name of the terminal where the customer logged in 

 Time In – Time when the customer logged in at the terminal 

 Time Out – Time when the customer logged out from the terminal 

 Employee Name – Name of the employee who was logged in at the CLINCK server when the customer visited 

 

To generate a daily register report, follow these steps: 

 

 

Note: The Date field in this report’s filter is mandatory. 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears with the 

current date’s daily register report. 

 

 

Note: If you are already in the Reports tab, in the left panel of the tab, click Daily Register Report. 

2) In the Date box of the report filter, select the date for which you want to view the daily register report. 

3) Click Show. 

Result: The daily register report for the selected date appears. 
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Figure 11.5: Daily Register Report 

 

Scroll right to see the rest of the report. 

 

11.2 Financial Reports 
 

11.2.1 Collection Report 
 

The Collection Report gives a list of each time money was collected from customers on a specific date or range of 

dates for any activity, including internet usage and the sale of products and services. The following information is 

displayed in the report: 

 

 Date – Date on which the money was collected 

 Time In – Time when the customer logged in at a terminal 

 Time Out – Time when the customer logged out from the terminal 

 Duration – Duration of the customer’s internet session at the terminal 

 Type – Type of customer 

 Customer Name – Name of the customer 

 Internet Usage – Amount charged to the customer for using the internet 

 Membership Package – Amount charged to the customer for a membership package 
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 Product Service – Amount charged for a product of service sold to the customer 

 Discount – Amount of discount given to the customer, if any 

 Total Amount – Total amount charged to the customer 

 Employee Name – Name of the employee who was logged in at the CLINCK server when the customer visited the 

cyber cafe 

 

To generate a collection report, follow these steps: 

 

 

Note: The From Date and To Date fields in this report’s filter are mandatory. The remaining fields 

are optional. 

 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Collection Report. The default Collection Report screen appears with 

the collection report for the current date. 

3) In the From Date box of the report filter, select the start date for the collection report. 

4) In the To Date box, select the end date for the report. 

5) In the Type box, select the type of customer for which you want the report. 

 

Note: If this field is left blank, the report is generated for all the three types of customers of your 

cyber cafe, that is, Registered Customers, Registered Members, and Walk-in Customers. 

 

6) In the Employee box, select the name of the employee whose collections you want view in the report. 

 

Note: If this field is left blank, the report is generated for all the employees of the cyber cafe. 

 

7) Click Show. 

 

Result: The collection report for the selected dates, customer type, and employee appears. 
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Figure 11.6: Collection Report 

 

Scroll right to see the rest of the report. 

 

11.2.2 Summary Collection Report 
 

The Summary Collection Report sums up and gives the financial result of collections and expenses for each date in 

the specified duration of time. The collections include money earned from internet usage and the sale of products 

and services, and the expenses include the money spent in buying products and providing services. This report is 

generally used to see the collections and expenses for a given date. The following information is displayed in the 

report for each date in the time range that you provide: 
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 Date – Date on which the money was collected or spent 

 Total Internet Usage – Total amount collected from customers for internet usage on that date 

 Total Membership Package – Total amount earned by selling membership packages to customers on that date 

 Total Sale – Total amount collected by selling products and services to customers on that date 

 Total Purchase – Total amount spent on purchasing products and providing services to customers on that date 

 Total Discount – Total amount of discount given to customers on that date   

 Total Amount – Difference between the total collections and the total expenses of that date 

To generate a summary collection report, follow these steps: 

 

Note: The From Date and To Date fields in this report’s filter are mandatory. 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Summary Collection Report. The default Summary Collection Report 

screen appears with the current month’s summary collection report. 

3) In the From Date box of the report filter, select the start date for the summary collection report. 

4) In the To Date box, select the end date for the report. 

5) Click Show. 

Result: The summary collection report for the selected range of dates appears. 

 

Figure 11.7: Summary Collection Report 
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Scroll right to see the rest of the report. 

 

11.2.3 Monthly Collection Report 
 

The Monthly Collection Report sums up and gives the financial result of collections and expenses for each month in 

the specified range of months. The collections include money earned from internet usage and the sale of products 

and services, and the expenses include the money spent in buying products and providing services. This report is 

generally used to see the collections and expenses for a given month. The following information is displayed in the 

report for each month in the range that you provide: 

 

 Month – Month in which the money was collected or spent 

 Total Internet Usage – Total amount collected from customers for internet usage in that month 

 Total Membership Package – Total amount earned by selling membership packages to customers in that month 

 Total Sales – Total amount collected by selling products and services to customers in that month 

 Total Purchase – Total amount spent on purchasing products and providing services to customers in that month 

 Total Discount – Total amount of discount given to customers in that month 

 Total Amount – Difference between the total collections and the total expenses of that month 

To generate a monthly collection report, follow these steps: 

 

 

Note: The From Month and Year, as well as To Month and Year fields in this report’s filter are 

mandatory. 

 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Monthly Collection Report. The default Monthly Collection Report 

screen appears with the current month’s monthly collection report. 

3) In the From Month and Year boxes of the report filter, select the starting month and year for the monthly 

collection report. 

4) In the To Month and Year boxes, select the ending month and year for the report. 

5) Click Show. 

 

Result: The monthly collection report for the selected range of months appears. 
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Figure 11.8: Monthly Collection Report 

 

Scroll right to see the rest of the report. 

 

11.2.4 Purchase Report 
 

The Purchase Report gives details of the products bought during a specific period of time. It can be generated for a 

particular date range or a particular product. The following information is displayed in the report for the time range 

and/or product that you provide: 

 

 Purchase Date – Date on which the product was purchased 

 Product Name – Name of the product 

 Price – Price of one unit of the product 

 Quantity – Quantity of product purchased 

 Total Price – Total price of product (That is, Price x Quantity) 

 

To generate a purchase report, follow these steps: 
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Note: The From Date and To Date fields in this report’s filter are mandatory. The remaining field is 

optional. 

 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Purchase Report. The default Purchase Report screen appears with the 

current month’s purchase report. 

3) In the From Date box of the report filter, select the start date for the purchase report. 

4) In the To Date box, select the end date for the report. 

5) In the Product Name box, select the product for which you want the report. 

 

Note: If this field is left blank, the report is generated for all the products purchased during the 

specified date range. 

6) Click Show. 

 

Result: The purchase report for the selected date range and product appears. 

 
Figure 11.9: Purchase Report 
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11.2.5 Invoice List Report 
 

The Invoice List Report gives details of all the invoices generated during a particular date range. The following 

information is displayed in the report for the range of dates that you provide: 

 

 Date – Date of invoice 

 Invoice No. – Invoice number 

 Customer Name – Name of customer 

 Customer Type – Type of customer 

 Internet Usage – Amount charged to the customer for using the internet 

 Membership Package – Amount charged to the customer for a membership package 

 Product Service – Amount charged for a product of service sold to the customer 

 Discount – Amount of discount given to the customer, if any 

 Total Amount – Total amount charged to the customer 

To generate an invoice list report, follow these steps: 

 

 

Note: The From Date and To Date fields in this report’s filter are mandatory. 

 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Invoice List Report. The default Invoice List Report screen appears with 

the invoice list report for the current date. 

3) In the From Date box of the report filter, select the start date for the invoice list report. 

4) In the To Date box, select the end date for the report. 

5) Click Show. 

 

Result: The invoice list report for the selected date range appears. 
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Figure 11.10: Invoice List Report 

 

Scroll right to see the rest of the report. 

 

11.2.6 Invoice Detail Report 
 

The Invoice Detail Report gives the details of a particular invoice. Since this is actually a bill of the cyber café, you 

can print this report to give to a customer as a bill. The following information is displayed in the report for the 

invoice number that you provide: 

 

 Invoice No. – Invoice number 

 Invoice Date – Date of invoice 

 Customer Name – Name of customer 

 Item Name – Name of item purchased (This could be internet usage, a product bought, or any other service 

taken from the cyber café) 

 Quantity – Quantity of product or service purchased 

 Price – Price of one unit of the product or service purchased 

 Total – Total price of product (that is, Quantity x Price) 
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To generate an invoice detail report, follow these steps: 

 

 

Note: The Invoice No. field in this report’s filter is mandatory. 

 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Invoice Detail Report. The default Invoice Detail Report screen appears 

with a report filter. 

3) In the Invoice No. box of the report filter, type the invoice number for which you want to view the details. 

4) Click Show. 

 

Result: The invoice detail report for the given invoice number appears. 

 

Figure 11.11: Invoice Detail Report 

11.2.7 Adjustment Report 
 

The Adjustment Report gives details of the discounts offered to customers by an employee. The following 

information is displayed in the report for the date range, employee, and customer that you specify: 

 

 Date-Time – Date and time when the invoice was generated and the discount was given 

 Customer Name – Name of customer 
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 Login Employee Name – Name of employee who logged in the customer  

 Logout Employee Name – Name of employee who logged out the customer  

 Discount Amount – Amount of discount given to the customer by the employee 

 Discount Description – Description of the discount 

 

To generate an adjustment report, follow these steps: 

 

 

Note: The From Date and To Date fields in this report’s filter are mandatory. The remaining fields 

are optional. 

 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Adjustment Report. The default Adjustment Report screen appears 

with a report filter. 

3) In the From Date box of the report filter, select the start date for the adjustment report. 

4) In the To Date box, select the end date for the report. 

5) In the Employee box, select the employee whose discounts given you want to view. 

 

Note: If this field is left blank, the report is generated for all the employees who gave discounts 

during the specified date range. 

 

6) In the Customer Name box, select the customer for whom you want to view the report. 

 

Note: If this field is left blank, the report is generated for all the customers to whom a discount was 

given during the specified date range. 

 

7) Click Show. 

 

Result: The adjustment report for the given date range, employee, and customer appears. 
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Figure 11.12: Adjustment Report 

Scroll right to see the rest of the report. 

 

11.3 Customer Reports 
 

11.3.1 Customer List Report 
 

The Customer List Report gives details of all the customers registered in your cyber café in a certain time range. A 

customer imported to the café’s CLINCK database from the online CLINCK database also becomes a local customer 

and appears in the report. The following information is displayed in the report for the date range and customer 

type that you specify: 

 

 Customer Name – Name of customer 

 Registration Date – Date when the customer was registered in the your café’s CLINCK database or imported to 

your database from the online CLINCK database 

 Login ID – Customer’s login ID 

 Customer Type – Type of customer 
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To generate a customer list report, follow these steps: 

 

 

Note: The From Date and To Date fields in this report’s filter are mandatory. The remaining field is 

optional. 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Customer List Report. The default Customer List Report screen appears 

with a report filter. 

3) In the From Date box of the report filter, select the start date for the customer list report. 

4) In the To Date box, select the end date for the report. 

5) In the Customer Type box, select the type of customers for whom you want to view the report. 

 

Note: If this field is left blank, the report is generated for all three types of customers of your cyber 

cafe, that is, Registered Customers, Registered Members, and Walk-in Customers. 

6) Click Show. 

 

Result: The customer list report for the given date range and customer type appears. 

 

Figure 11.13: Customer List Report 

11.3.2 Customer History Report 
 

The Customer History Report gives a record of all or a particular customer’s sessions at your cyber café in a given 

time range. The following information is displayed in the report for the specified date range and customer: 

 



176   |   Chapter 11 

             

              

              

               176                  

 

 Date – Date of session 

 Customer Name – Name of customer 

 Time In – Start time of session 

 Time Out – End time of session 

 Duration – Duration of session 

 Terminal Name – Name of terminal where the session took place 

 

Note: The Customer History Report does not give a record of the customer’s sessions in cyber cafes 

other than your own. 

To generate a customer history report, follow these steps: 

 

Note: The From Date and To Date fields in this report’s filter are mandatory. The remaining field is 

optional. 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Customer History Report. The default Customer History Report screen 

appears with a record of all the internet sessions that took place at your cyber café on the current date. 

3) In the From Date box of the report filter, select the start date for the customer history report. 

4) In the To Date box, select the end date for the report. 

5) In the Customer Name box, select the customer for whom you want to view the report. 

 

Note: If this field is left blank, the report is generated for all the customers of your cyber cafe. 

6) Click Show. 

 

Result: The customer history report for the given date range and customer appears. 
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Figure 11.14: Customer History Report 

11.3.3 Customer Details Report 
 

The Customer Details Report gives all the details of a particular customer. You can select a customer from the list 

provided on top. The following information is displayed in the report for the selected customer: 

 

 Customer Name – Name of customer 

 Login ID – Customer’s login ID 

 Address – Customer’s address 

 ID Card Type – Type of ID card provided by the customer 

 ID Card No. – ID card number 

 Other Information – Other information saved about the customer 

 Customer’s picture 

 Picture of customer’s photo ID 

To generate a customer details report, follow these steps: 

 

Note: The Customer Name field in this report’s filter is mandatory. 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Customer Details Report. The default Customer Details Report screen 

appears with a report filter. 

3) In the Customer Name box, select the customer for whom you want to view the report. 

4) Click Show. 

 

Result: The customer details report for the given customer appears. 
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Figure 11.15: Customer Details Report 

11.3.4 Member History Report 
 

The Member History Report gives a record of how a member of your cyber café has used his/her membership 

package. This report is generally needed when a member asks for details about his/her membership usage. The 

following information is displayed in the report for the selected customer: 

 Date – Date when a membership package was used 

 Time In – Time when the customer logged in at a terminal 

 Time Out – Time when the customer logged out from the terminal 

 Duration – Duration of internet session 

 Time Used – Time when the membership package was used 

 Purchase Date – Date when the package was purchased  

 Package Name – Name of the membership package 

 Days Left – Days left till the package is valid 

 Time Left – Time remaining to be used in the package 

To generate a member history report, follow these steps: 

 

Note: The Customer Name field in this report’s filter is mandatory. 
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1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Member History Report. The default Member History Report screen 

appears with a report filter. 

3) In the Customer Name box, select the customer for whom you want to view the report. The following details 

appear next to the customer’s name: 

 Current Package – Name of the customer’s current membership package 

 Total Minutes Granted – Total number of minutes granted in the membership package 

 Price – Price of the membership package 

4) Click Show. 

 

Result: The member history report for the given customer appears. 

 

 
Figure 11.16: Member History Report 

11.3.5 Member List Report 
 

The Member List Report gives the package details of all the registered members of your cyber café. The following 

information is displayed in the report for the selected date range, customer, and membership package: 

 

 Customer Name – Name of customer 

 Package Name – Name of membership package 
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 Purchase Date – Date when the membership package was purchased  

 Validity Date – Date by which the membership package must be used 

 Expiry Date – Date after which balance minutes left in the package cannot be carried forward 

 Carry Forward Time – Amount of time carried forward 

 Total Time – Total time in the package including time carried forward  

 Amount Paid – Amount paid for the package (or package price) 

 Time Used – Amount of time used out of the total time 

 Days Left – Days left till the package is valid 

To generate a member list report, follow these steps: 

 

 

Note: The Purchase Date (From) and Purchase Date (To) fields in this report’s filter are 

mandatory. The remaining fields are optional. 

 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Member List Report. The default Member List Report screen appears 

with a report filter. 

3) In the Purchase Date (From) box, select the start date for the member list report. 

4) In the Purchase Date (To) box, select the end date for the report. 

5) In the Customer Name box, select the customer for whom you want to view the report. 

 

Note: If this field is left blank, the report is generated for all the customers of your cyber cafe. 

 

6) In the Package Name box, select the membership package for which you want the report. 

 

Note: If this field is left blank, the report is generated for all the types of membership packages 

offered by the cyber cafe. 

 

7) Click Show. 

 

Result: The member list report for the given date range, customer, and membership package appears. 
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Figure 11.17: Member List Report 

 

Scroll right to see the rest of the report. 

 

11.4 Café Management Reports 
 

11.4.1 Terminal Usage Report 
 

The Terminal Usage Report gives details about which terminal is being used how many time by customers. The 

following information is displayed in the report for the selected date range, terminal, and customer type: 

 

 Date – Date when the terminal was used 

 Terminal Name – Name of the terminal 

 Customer Name – Name of the customer who used the terminal 

 Customer Type – Type of customer  

 Time In – Time when the customer logged in at the terminal 

 Time Out – Time when the customer logged out from the terminal 

 Duration – Duration for which the customer was logged in at the terminal 
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To generate a terminal usage report, follow these steps: 

 

Note: The From Date and To Date fields in this report’s filter are mandatory. The remaining fields 

are optional. 

 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Terminal Usage Report. The default Terminal Usage Report screen 

appears with the terminal usage report for the current date. 

3) In the From Date box, select the start date for the terminal usage report. 

4) In the To Date box, select the end date for the report. 

5) In the Terminal Name box, select the terminal for which you want to view the report. 

 

Note: If this field is left blank, the report is generated for all the terminals in the cyber café that are 

connected to the CLINCK server. 

6) In the Customer Type box, select the type of customer for which you want the report. 

 

Note: If this field is left blank, the report is generated for all three types of customers of your cyber 

cafe, that is, Registered Customers, Registered Members, and Walk-in Customers. 

7) Click Show. 

 

Result: The terminal usage report for the given date range, terminal, and customer type appears. 

 
Figure 11.18: Terminal Usage Report 
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11.4.2 Server Up Time Report 
 

The Server Uptime Report gives a record of every time the CLINCK server was started and closed. The following 

information is displayed in the report for the selected date range: 

 

 Start Time – Time when the CLINCK server was started 

 Close Time – Time when the server was closed 

To generate a server up time report, follow these steps: 

 

Note: The From Date and To Date fields in this report’s filter are mandatory. 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Server Up Time Report. The default Server Up Time Report screen 

appears with the server up time report for the current date. 

3) In the From Date box, select the start date for the server up time report. 

4) In the To Date box, select the end date for the report. 

5) Click Show. 

 

Result: The server up time report for the given date range appears. 

 
Figure 11.19: Server Up Time Report 
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11.4.3 Close Café Client Report 
 

The Close Cafe Client Report gives details about how many times a terminal’s client application was closed by an 

employee. The following information is displayed in the report for the selected date range: 

 Close Time – Time when the CLINCK client was closed on a terminal 

 Start Time – Time when the client was started on the terminal 

 Terminal Name – Name of the terminal 

 Employee Name – Name of employee who closed the client application  

 Type – Type of employee 

 From Server – Whether the client application on the terminal was closed from the CLINCK server 

To generate a close café client report, follow these steps: 

 

Note: The From Date and To Date fields in this report’s filter are mandatory. The remaining fields 

are optional. 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Close Café Client Report. The default Close Café Client Report screen 

appears with the report filter. 

3) In the From Date box, select the start date for the close café client report. 

4) In the To Date box, select the end date for the report. 

5) In the Employee box, select the employee for whom you want to view the report. 

 

Note: If this field is left blank, the report is generated for all the employees of the cyber café. 

6) In the Type box, select the type of employee for which you want the report. 

 

Note: If this field is left blank, the report is generated for all the types of employees in your cyber 

café, that is, Online Verification, Administrator, and Employees. 

7) Click Show. 

 

Result: The close café client report for the given date range, employee, and employee type appears. 
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Figure 11.20: Close Café Client Report 

Scroll right to see the rest of the report. 

 

11.5 Product & Service Reports 
 

11.5.1 Product List Report 
 

The Product List Report gives details of all the products sold by the cyber café along with their available quantity. 

The following information is displayed in the report for the selected product: 

 Product Name – Name of product 

 Available Quantity – Quantity of product available in the cyber cafe 

 Sales Price – Product’s selling price 

 Average Purchase Price – Average price at which the product is purchased 

To generate a product list report, follow these steps: 

 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Product List Report. The default Product List Report screen appears 

with a list of all the products offered by the cyber cafe. 

3) In the Product Name box, select the product whose details you want to view separately. 

4) Click Show. 

 

Result: The product list report for the given product name appears. 
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Figure 11.21: Product List Report 

 

11.5.2 Product and Service Consumption Report 
 

The Product and Service Consumption Report gives the details of products and services sold by your cyber café 

during a selected date range. The following information is displayed in the report for the date range and product 

that you specify: 

 Item – Name of the product or service sold 

 Quantity Sold – Total quantity of the product or service sold during the specified time period 

 Price – Price of the product or service 

 Total – Total price of the product or service sold (that is, Quantity Sold x Price) 

 Quantity Balance – Quantity of the product or service remaining in the cyber cafe 

To generate a product and service consumption report, follow these steps: 

 

 

Note: The From Date and To Date fields in this report’s filter are mandatory. The remaining field is 

optional. 

 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 
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2) In the left panel of the Reports tab, click Product and Service Consumption Report. The default Product and 

Service Consumption Report screen appears with the report for the current date. 

3) In the From Date box, select the start date for the report. 

4) In the To Date box, select the end date for the report. 

5) In the Item Name box, select the product or service for which you want to view the report. 

 

Note: If this field is left blank, the report is generated for all the products and services sold by the 

cyber café. 

6) Click Show. 

 

Result: The product and service consumption report for the given date range and product/service appears. 

 

Figure 11.22: Product and Service Consumption Report 

11.6 Printer Reports 
 

11.6.1 Printer Usage Report 
 

The Printer Usage Report gives details of all the print jobs that took place in a given date range. You can also select 

the printer, customer, terminal, and employee for which you want to see the report. The following information is 

displayed in the report for the date range and product that you specify: 

 Date – Date of the print job  

 Printer Name – Name of the printer where the print job took place 

 Terminal Name – Name of the terminal from which the print job was requested 
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 Customer Name – Name of the customer who requested the print job 

 Employee Name – Name of employee who was logged in at the CLINCK server at the time of the print job 

 Document Name – Name of the document printed 

 Total Pages – Total number of pages printed 

 

To generate a printer usage report, follow these steps: 

 

 

Note: The From Date and To Date fields in this report’s filter are mandatory. The remaining fields 

are optional. 

 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Printer Usage Report. The default Printer Usage Report screen appears 

with the printer usage report for the current date. 

3) In the From Date box, select the start date for the report. 

4) In the To Date box, select the end date for the report. 

5) In the Printer Name box, select the printer for which you want to view the report. 

 

 

Note: If this field is left blank, the report is generated for all the printers in the cyber café that are 

connected to the CLINCK server. 

6) In the Customer Name box, select the customer for whom you want the report. 

 

 

Note: If this field is left blank, the report is generated for all the customers of your cyber café. 

7) In the Terminal Name box, select the terminal for which you want the report. 

 

 

Note: If this field is left blank, the report is generated for all the terminals in the cyber café that are 

connected to the CLINCK server. 

8) In the Employee Name box, select the employee for whom you want the report. 

 

 

Note: If this field is left blank, the report is generated for all the employees of the cyber café. 

9) Click Show. 

 

Result: The printer usage report for the given date range, printer, customer, terminal, and employee appears. 
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Figure 11.23: Printer Usage Report 

 

Scroll right to see the rest of the report. 

 

11.6.2 Printer Summary Report 
 

The Printer Summary Report gives a summary of the prints taken from a particular printer. The following 

information is displayed in the report for the date range and printer that you specify: 

 

 Printer Name – Name of the printer 

 Total Pages – Total number of pages printed 

 Total Amount – Total amount charged to the customer for the pages printed 

 

 

Note: The amount is calculated using the rate of the service selected for each printer. 
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To generate a printer summary report, follow these steps: 

 

Note: The From Date and To Date fields in this report’s filter are mandatory. The remaining field is 

optional. 

 

1) On the CLINCK server screen, click the Reports tab. The default Daily Register Report screen appears. 

2) In the left panel of the Reports tab, click Printer Summary Report. The default Printer Summary Report screen 

appears with the printer summary report for the current date. 

3) In the From Date box, select the start date for the printer summary report. 

4) In the To Date box, select the end date for the report. 

5) In the Printer Name box, select the printer for which you want to view the report. 

 

Note: If this field is left blank, the report is generated for all the printers in the cyber café that are 

connected to the CLINCK server. 

6) Click Show. 

 

Result: The printer summary report for the given date range and printer appears. 

 
Figure 11.24: Printer Summary Report 
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Chapter 12: Backup and Restore 
 

12.1 Backups 
 

Taking regular backups is a part of the café manager’s activity. Backup refers to maintaining a copy of database on a 

removable disk like CD/DVD or on a different machine, which is used in the event of system failure. 

 

12.1.1 Database Backups 
 

Database Backups allow you to maintain backups of database on a different system or removable disk.  

 

Note: Create a database backup every 2 to 3 days. 

 

To maintain Backup of files, do the following: 

 

1) On the File menu, click Backup. 

 

 
Figure 12.1: File – Backup 

Backup dialog box opens. 
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Figure 12.2: Backup Application 

2) In the Backup Application dialog box, do the following: 

 

Note: See Figure 12.2 for Backup. 

 Enter Backup File Name 

 Click Browse and select the folder path, to save the backup file. 

3) Click Start Backup. 

A dialog box confirming the successful completion of backup opens. 

 
Figure 12.3: Backup  

4) Click OK. 

Result: Backup is done successfully. 

12.1.2 Schedule Backups 
For the safety of data, always take regular backups. With Schedule Backups, system takes automatic backups on 

regular intervals, during a particular time of the day. 

 

Note: The backup scheduler does not overwrite old backups. Each time the scheduler runs, a new 

backup file is created at the folder location specified. 

To maintain scheduled backups, do the following: 

1) On the File menu, click Schedule Backups.  

 

Figure 12.4: File - Schedule Backups  
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The Schedule Backups dialog box opens. 

 

 

 

 
 

Figure 12.5: Schedule Backups  

2) In the Schedule Backups dialog box, do the following: 

 

Note: See Figure 12.5 for Schedule Backups. 

 

a. To perform backups every time the server application is closed, do the following:  

 Select Perform a backup every time I close the server application. 

With this feature, you will be prompted to take backups each time the CLINCK Cyber Café Manager 

Server closes, as shown in Figure 12.6. 

 Click Browse. 

With this option, you can choose a folder path, to maintain backup. 

 Enter Keep only last. 

With this feature, a minimum of three backup copies are maintained. 

 

 

Note: See Figure 12.6 for Auto Backup. 

 

Performs backup, when the 

application is closed 

Scheduled backups 



194   |   Chapter 12 

             

              

              

               194                  

 

 
Figure 12.6: Auto Backup  

 Click Take Backup and Close. 

        With this option, a backup is taken before the CLINCK Cyber Café Manager Server closes. 

 Click Skip Backup and Close. 

        CLINCK Cyber Café Manager Server closes, without taking a backup. 

 Click Cancel.  

        With this option, the CLINCK Cyber Manager Server screen opens. 

b. To perform schedule backups, do the following: 

 

Note: See Figure 12.5 for Schedule Backups. 

 Select Perform Schedule Backup. 

             With this feature, timely backups based on the schedule are taken. 

 Enter Backup after every day(s)  

                  With this feature, backup is taken for the scheduled days. 

 For example, for a daily backup, enter “1”. 

 

Note:  

� Always select a time when the CLINCK Cyber Café Manager Server is running.   

� If the server application is closed at the specified time of the backup, backup is taken immediately 

after the server is executed. 

 Select the time at which the backup must be taken. 

 Click Browse 

            With this option, you can choose a folder path, to maintain backup. 

 Enter Keep only last. 

            With this feature, a minimum of three backup copies are maintained. 

3) Click OK. 

 

Note:  

� Even after scheduling the backups, still regular backups can be taken using File > Backup.  

� See Figure 12.1 for Backup. 

Result: Scheduled Backups are taken successfully. 

 

12.2 Database Restore 
 

Database Restore helps in restoring the backed up files. To restore the database, do the following: 

a. On the File menu, select Restore. 
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Figure 12.7: File – Restore 

The Restore dialog box opens. 

 

Figure 12.8: Database Restore 

4) In the Restore dialog box, do the following: 

 Click Browse 

 With this option, choose the folder path, to restore the backup file. 

5) Click Restore. 

Restore Backup dialog box opens. 

 
Figure 12.9: Restore Backup 

6) Click Yes. 

Restore Backup dialog box opens, informing you about the successful completion of the restore process. Now, 

the CLINCK Cyber Café Manager restarts. 
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Figure 12.10: Successful Completion of Restore Backup  

 

7) Click OK. 

CLINCK Cyber Café Manager Server restarts and the Server Login dialog box opens. 

 

 

Figure 12.11: Server Login 

 

Result: The database backup is restored successfully. 
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Chapter 13: User Accounts and Access 

Permissions 
 

The person who administers the Café has full rights, compared to the employees, who work under him. The admin 

adds new employees to the Café and assigns only certain rights to them.  

This is discussed in detail in this chapter.  

 

13.1 To Add a New Employee 
 

Employee tab is used to create and manage employees accessing the CLINCK Cyber Café Manager. When many 

people work in the café, then this tab is used to create multiple employee logins.  A separate login account must be 

created for everyone managing the Cyber Café Manager, so that it allows the manager to track the activities 

performed by each employee separately. 

 

 

Note: A default user Admin is already present on the system, and as an Administrator only he can 

close the CLINCK Cyber Café application. 

 

 

 

Figure 13.1: Manage Employee Accounts 

 

To add a new employee, do the following: 

 

1)  Select Employees > Add New Employee on the Home page 

       Add / Edit Employee Details dialog box opens. 

Employees Related Reports  
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Figure 13.2: Add / Edit Employee Details 

 

2) In the Add / Edit Employee Details dialog box, do the following: 

 

 Enter Employee Name 

 Select Employee Type 

 Enter Password  

    Enter Confirm Password 

 

 

Note: In selecting an Employee Type, an Administrator has full rights, but an Employee has only 

limited rights. If the user is selected as an employee, then he can be given rights to change the rate 

plans, to delete customers, etc. 
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Figure 13.3: Add / Edit Employee Details 

 

3) Click Next. Add / Change Employee permissions dialog box opens. 

4) Select the permissions to be assigned to the employee. 

 

 

Figure 13.4: Add / Edit Employee Details 
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Note: Reset to Default button is used to undo any changes you have made and start again. 

5) Click Finish. 

In the example, an employee by name “Prithvi” is added as a New Employee. 

 

 

Figure 13.5: Manage Employee Accounts 

 

 

Note: Employees tab has the following report: 

� Close Café Client Report, see section 11.4.3 

For more information on reports, see Chapter 11. 

 

Result: A New Employee is added. 

 

13.2 To Edit Employee Details 
 

The Edit button in the Manage Employee Accounts is used to edit employee details such as his name, login id and 

so on. 

 

Note: Only employees with admin rights can edit employee details. 

 

1) The steps to edit the employee details are as follows: 

 

 Select an Employee 

 Click Edit  
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Figure 13.6: Manage Employee Accounts 

 

       Add/Edit Employee Details dialog box opens. 

 

Figure 13.7: Add / Edit Employee Details 

 

2) In the Add/Edit Employee Details dialog box, do the following: 

 Enter Employee Name 

 Enter Password and Confirm Password 
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Figure 13.8: Add / Edit Employee Details 

 

3) Click Finish. 

      The Employee Details are edited.  

 

Result: User Accounts are created with certain access rights.  
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Chapter 14: Help 
 

The CLINCK Cyber Café Manager provides different ways to get help related to the cyber café management. You can 

use one or more of the following help options: 

 

 Quick Help 

 FAQ 

 Online Help 

 How To Start 

 Contact Us/Live Support 

 

Each of these help options is explained in this chapter. 

 

14.1 Quick Help 
 

A different Quick Help section appears for every menu tab on the CLINCK server screen. It provides explanations 

and instructions related to the CLINCK Cyber Café Manager’s frequently used features and tasks appearing under 

that particular tab. For example, the Quick Help section of the Home tab provides help on topics related to 

managing terminals and sessions. 
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Figure 14.1: Example of Quick Help 

 

14.2 FAQ 
 

The FAQ option takes you to a web page that provides answers to frequently asked questions related to the CLINCK 

Cyber Café Manager.  

 

It is available under the CLINCK server’s Help menu and under the How To Start tab. Moreover, you can also access 

the FAQs directly from the partners website - http://partners.ideacts.com 

Quick Help 
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Figure 14.2: Frequently Asked Questions (FAQ) 

 

14.3 Online Help 
 

The Online Help option opens a user guide for the CLINCK Cyber Café Manager in PDF format. It is available under 

the CLINCK server’s Help menu and under the How To Start tab. Moreover, you can also access the online help 

directly from the partners website - http://partners.ideacts.com 
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Figure 14.3: User guide to CLINCK Cyber Café Manager in PDF format 

 

14.4 How To Start 
 

How To Start is a 3-step guide on how to start using the CLINCK Cyber Café Manager. It is available under the 

CLINCK server’s Help menu and also under the How To Start tab. 
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Figure 14.4: How To Start tab 

 

 

Note: See Section 2.2.1 for more information on the 3-step guide on how to start the CLINCK Cyber 

Café Manager. 

 

14.5 Contact Us/Live Support 
 

The Contact Us/Live Support option is available in the CLINCK server’s main menu and also under the How To Start 

tab. It opens the Contact Us dialog box which has the contact details of the Ideacts Account Manager and a Live 

Support button to send your support request to Ideacts online. A support executive responds to the support 

request within four hours. 
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Figure 14.5: Contact Us/Live Support dialog box 
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